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Network Overview

LAN

Machine Service(s) IP Address | FQDN
pfSense Firewall | - Internal Caching DNS | 10.161.21.4 | pfsense.slick.firewall

- WireGuard VPN
Windows Server | - AD Domain Controller | 192.168.2.2 | slickbrickcentral.com

- AD Domain: ad.local (web server)

ubuntu.slickbrickcentral.com

Ubuntu Server - BIND DNS 192.168.2.3 | win.slickbrickcentral.com

- Apache Web Server

Y B ™

N
; WAN Gateway IP; 10.161.21.1
/

I
=

WAN Machine
IP Address: 10.161.21.20

WAN: 10.161.21.0/24

UNI DNS Servers:
+10.120.16.10
+10.120.16.11

pfSense Firewall
WAN Firewall IP: 10.161.21.4

Internal Caching DNS IP Address:

+ LAN Access --> 192.168.1.1
+ DMZ Access --> 192.168.2.1

LAN Gateway Address:

192.168.1.1

LAN Network Address:

192.168.1.0/24
A—

dhcp IP Address Range: B
192.168.1.101-254 4 >
—’

4

DMZ

DMZ Gateway Address:
‘ 192.168.2.1

DMZ Network Address:
192.168.2.0/124

W11 Workstation: WS-1
Active Directory: ad.local

W11 Workstation: WS-2
Active Directory: ad.local

Windows 2022 Server
IP Address: 192.168.2.2
Services:

« AD Domain Controller
« AD Domain: ad.local

Ubuntu Linux Server

IP Address: 192.168.2.3
Services:

= BIND DNS

» Apache HTTPS Server

WireGuard

WireGuard Port: 51820 (default)

Internal VPN Subnet: 192.168.3.0/24
WAN Client IP: 10.161.21.20

Internal Client IP Assignment: 192.168.3.2




Project 1: Linux Server

Below contains steps outlining the configuration of an Ubuntu Linux Server that will be used to
host a Static HTTPS Web Server and BIND for Internal DNS mappings. The Linux Server will
start in the WAN under the Static IP Address: 10.161.21.2.

VM Configuration

Guest Os: Linux (64 Bit)
Hardware: 2 CPUs, 8 GB RAM, Thin Provision, Use Datastore ISO file
ISO file: Ubuntu 24.04 Live Server

Final VM Specifications:
Virtual Hardware VM Options

ADD NEW DEVICE ~

> CPU 2 v ®
> Memory v GB
> Hard disk 1 60 GB ~
y SCSI controller O VMware Paravirtual
y Network adapter 1 SysAdmin021 v Connected
s CD/DVD drive 1 Datastore ISO File w Connected
» Video card Specify custom settings v
» Security Devices Mot Configured

VMCI device

SATA controller O AHCI
> Other Additional Hardware



Ubuntu Server Setup

Network Configuration

Subnet: 10.161.21.0/24 (.21 is signifying the subnet | was assigned for the semester)
Linux Server Static IP: 10.161.21.2

Gateway: 10.161.21.1

Nameservers (DNS): UNI DNS Servers - 10.120.16.10 and 10.120.16.11

Network configuration [ Help ]

Edit en IPv4 confi

IPv4 Method: [ Manual r]

Subnet: TOSIGIN2IN0A245

Assigned NO Proxy. A proxy is a “middle man” to filter network traffic coming out and/or in
Linux Mirror: US Repository Address
Ubuntu archive mirror configuration

mirror for Ubuntu, e s details here.

http://us.archive.ubuntu.com/ubuntu/

This mirror location

[ Done
[ Back




Continue WITHOUT Updating the Installer
Storage Configuration: Use entire disk with 1 partition

Guided storage configuration [ Help ]
Configure a guided storage layout, or create a custom one:
(%) Use an entire disk

[ /dev/sda local disk 60.000G ¥

[¥] Set up this disk as an LWM group

[ 1 Encrypt the LVM group with LUKS

Storage configuration

FILE SYSTEM SUMMARY

[/ 28.996G new extd new LYM logical volume L
[ /boot 2.000G new ext4 new partition of local disk »

AVAILABLE DEVICES

[ ubuntu-vg (new) LVM volume group
free space

USED DEVICES

[ ubuntu-wg (new) LYM volume
ubuntu-1lv new, to be formatted as extd4, mounted at

[ /dev/sda local disk
partition new, BIODS grub spacer

partition new, to be formatted as extd, mounted at
partition new, PY of LYM volume group ubuntu-vg

Profile Configuration: Username: **Classified**, Password: **Classified**

Profile configuration [ Help 1
Enter the username and password you will use to log in to the system. You can configure 5SH access on a later screen, but a
passward is still needed for sudo.

boontoo_boi_

Choose a password:

Conf irm your password:




SSH Configuration: NO OpenSSH Server

S8H configuration [ Help ]

¥ou can cC to = the 0Op S er pac 0 enable ure remote ¢ to your

[ 1 Install Of

AUTHORIZED K




Linux Server Guide

Directories

e /home - a user’s folder that contains personal data and configuration files for programs
on the machine. System programs and applications are NOT stored here.

e /var/lwww - a common place to store web content such as HTML, CSS, JavaScript, etc.
The var directory is known to store “variable” (changing) data which makes sense since
websites frequently update.

e Jvarl/log - contains log files generated by system and user applications. The logs can
include system messages, error messages, security alerts, etc. If someone was
accessing my server via ssh, | would likely be able to see a log of where and when the
person logged in.

e Jetc - contains system-wide configuration files that control various aspects of the
operating system and system processes. It typically includes configuration files for
system services, networking, user accounts, and security settings.For example, the
/etc/passwd file contains usernames and user ids while the /etc/shadow file stores
hashed passwords.

Commands

e Is -a = the “a” flag stands for ALL so the command Is -a is “listing ALL files”

e sudo = “sudo” is short for “super user do”. This is used to allow the current user to have
elevated command privileges. It is commonly used to perform administrative tasks within
the terminal that require higher clearance than the regular user. The sudo command
prompts you for your password to confirm your identity and then allows admin privileges.

o You can use the sudo command to update packages and software on the device
within the terminal using the two commands: sudo apt update and sudo apt
upgrade.



Package Management

How do you look for packages to install?

You can search for packages using the following command: sudo apt search

<package _name>. This command will list all packages that match the search term.

You can view all available versions of a package with the command: apt list --all-versions
<package name>

You can also see what packages have newer versions by running the command: sudo
apt update and then: sudo apt upgrade to upgrade all installed packages to their newer
versions.

How do you install a package?

You can install a package using the command: sudo apt install <package_name>. This
command will install the specified package and its dependencies.

How do you see what packages are already installed?

You can check for installed packages using the command: apt list —installed. This
command will list all of the system’s installed packages.

How do you remove a package?

You can remove a package with the command: sudo apt remove <package name>. This
command will remove the specified package but leave the configuration files. You can
use the “purge” keyword to recursively delete package files and its configurations with
the command: sudo apt purge <package name>.

After removing or purging a package, you can clean up any unused dependencies with
the command: sudo apt autoremove.

Services

You can list all running services with the command: systemctl list-units --type=service
--state=running or service —status-all.

Start a service: sudo systemcil start <service_name>

Stop a service: sudo systemctl stop <service_name>

Restart a service: sudo systemctl restart <service_name>

Service status: systemctl status <service_name>



Cron Jobs

Cron Jobs are automated scripts that run on specific time intervals. You can find cron jobs in a
variety of different places within the /etc directory:

letc/cron.hourly = hourly scripts

letc/cron.daily = daily scripts

letc/cron.weekly = weekly scripts

letc/cron.monthly = monthly scripts

letc/crontab = the system wide cron table where jobs are defined and scheduled, can
be accessed by super user -> sudo

letc/cron.d = application specific cron jobs and system maintenance tasks
Ivar/spool/cron/crontabs/<username> = user specific cron jobs are located here (you
can create and edit cron jobs with the command: crontab -e)

Adding Cron Jobs

You can add cron jobs to the current user using the crontab utility: crontab -e or the root
user using the command: sudo crontab -e

You then can add a cron job with a path to your script in this format: * * * * *
Ipath/tolyour/script.sh

You can also add a cron job file to the /etc/cron.d directory by using the command: sudo
nano /etc/cron.d/my_cron_job. You then add the path to your script with the same format
as above!

Crontab Commands:

T 3= = A I

crontab -e = create crontab file for current user
crontab -| = list cron jobs for the current user (my user has none hence the comments

only)
crontab -r = remove crontab file

i

cron.
run has to be defined through a single line
ng with different s when the ta: 1111 be run
crm !|I|| to run '.|||' 1
o define the time you can provide concrete vs
, hour (h), day of o (com), n

dow) or use "' In these fie

ice that + s will be started on the cron's system
daemon’s notion of time and timezo

Output of the ntab luding e ) is sen rough
email to th f g=1s

or more information see the manual p: of | and cron(g)

dom mon dow command



User Management

Adding Users
1. sudo useradd <new_username> = adds new user
2. sudo passwd <new_username> = set a password for new user
3. sudo useradd -m <new_username> = adds a new user with a home directory (-m flag)

Removing Users
1. sudo userdel <username> = deletes a user (does not remove their home directory)
2. sudo userdel -r <username> = deletes a user and their home directory (-r flag)

File Permissions

First character indicates the type of file:

e d = directory
e - =regular file
e | = symbolic link

Next nine characters represent the permissions for the owner, group, and others:

Owner Permissions (first three characters): Example -> rwx
e r =read permission
e w = write permission
e X = execute permission

Group Permissions (next three characters): Example -> r-x
e r =read permission
e - =NO write permission
e X = execute permission

Others Permissions (last three characters): Example rw-
e r =read permission
e w = write permission
e - =NO execute permission

10



Changing Permissions

You can change the permissions by using the chmod command.

Numeric Method
Ex: chmod 755 <filename>

Each permission is represented by a number:
e r(read)=4
o w (write) =2
e X (execute) =1

755 means:
e Owner: 7 (4+2+1 = rwx)
e Group: 5 (4+1 =r-x)
e Others: 5 (4+1 =r-x)

Symbolic Method
Ex: chmod u+rwx,g+rx,0+rx <filename>
e U (user/owner), g (group), o (others)
e + (add permission), - (remove permission)

Ex: What does “drwxr-xr-x” mean?

d = directory.

rwx = the owner has read, write, and execute permissions
r-x = the group can read and execute but not write

r-x = others can read and execute but not write

11



Project 2: Windows Server

Below contains steps outlining the configuration of a Windows 2022 Server that will be used to

initially configure pfSense through the admin portal in a browser and serve as an Active
Directory Domain Controller. The Windows Server will start in the WAN under the Static IP
Address: 10.161.21.3.

VM Configuration

Guest OS: Microsoft Windows Server 2022
Hardware: 4 CPUs, 16 GB RAM, Thin Provision, Use Datastore ISO file
ISO File: Windows Server 2022

Final Specifications
Virtual Hardware VM Options

ADD NEW DEVICE ~

> CPU 4 v @
> Memory v GB v
> Hard disk 1 90 GB v
» SCSI controller O LSI Logic SAS
y» Network adapter 1 SysAdmin021 ~ Connected
s CD/DVD drive 1 Datastore ISO File v Connected
s> USB xHCI controller USB 3.1
» Video card Specify custom settings v
> Security Devices Not Configured

VMCI device

SATA controller O AHCI

12



Windows Server Setup

Windows Installer
Select Language and Keyboard and then click “Next”.

4 Microsoft Server Operating System Setup

Language to install: {Eny (United States) T4

Time and currency format: [EEEAIERERE] -

Enter your language and other preferences and click "Next" to continue.

n. All rights reserved.

OS Choice: Windows Server 2022 (Desktop Experience)

& .(‘»:J Microsoft Server Operating System Setup

Select the operating system you want to install

Operating system Architecture Date modified
Windows Server 2022 Standard 11/5/2022
Windows Server 2022 Standard (Desktop Experience) 2
Windows Server 2022 Datacenter 11/5/2022
Windows Server 2022 Datacenter (Desktop Experience) 11/5/2022

Description:
This option installs the full Windows graphical environment, consuming extra drive space. It can be
useful if you want to use the Windows desktop or have an app that requires it.

Accept Terms and Conditions (74

13



Designate a Custom Install
@ “;J Microsoft Server Operating System Setup
Which type of installation do you want?

Upgrade: Install Microsoft Server Operating System and keep files, settings, and
applications

The files, settings, and applications are moved to the new

nly available when a supported version o
puter.

Custom: Install Microsoft Server Operating System only (advanced)
The files, settings, and applications aren't moved to the new operating system with this option. If
yeu want to make changes to partitions and drives, start the computer using the installation disc
commend backing up your files before you continue

Do not edit the drive. Click NEXT to use the full partition.
@ .@ Microsoft Server Operating System Setup
Where do you want to install the operating system?

Name Total size Free space Type

= Drive 0 Unallocated Space 900 GB 90.0 GB

+4 Refresh

# Format

% Load driver

14



Sit Tight and Watch the Installation Screen. If you stare too long you might become a
Grandpa (!

é] Microsoft Server Operating System Setup

Installing Microsoft Server Operating System

Status

” Copying Micresoft Server Operating System files
Getting files ready for installation (69%)
Installing features
Installing updates

Finishing up

Set Administrator Password

Customize settings
Type a password for the built-in administrator account that you can use to sign in to this computer,
Uséer namie

Password

Reenter password

You will then be prompted to restart the device to solidify the installation.

15



Windows Server Configuration

Login to Windows after restart and setup Network Settings by right clicking the “Globe” on the

bottom right and selecting “Open Network and Internet settings”

ROLES AND SERVER GROUPS

oles Server groups Servers total

i File ?nd Storage 1 I acalseives 1
Services
@ Manageability @ Manageability
Events Events
Performance Services
BPA results Performance
BPA results

Troubleshoot problems

Open Network 8¢ Internet settings

Navigate to Ethernet and “Change adapter options”

MNetwork & Internet

& status Related settings

Change adapter options

= Ethemnet

Right click the Ethernet icon and select “Properties”

iy NEtWI:IQCOr‘InECtiOﬂS
' 4 UK <« Metwork and Internet » Metwork Connections

Organize * Disable this network device Diagnose this connectio

l: Ethernetd
B~ Unidentified network
G Intel(R) 82574L Gig~ithinbrmntes
& Disable
Status

Diagnose
® Bridge Connections

Create Shortcut
Delete

Rename

e|e e

Properties

16



Navigate to Internet Protocol Version 4 (IPv4) and select “Properties”

S gD EMIR | R Pl P T

Intemet Protocol Version 4 (TCP/IPv4)
(] 4 Microsoft Network Adapter Multiplexor Protocol
W 5 Microsoft LLDP Protocol Driver
v 4 Intemet Protocol Version & (TCP/IPv6) v
< >

install.. Uninstal | Propesties

Network Configuration

Subnet: 10.161.21.0/24 (.21 is signifying the subnet | was assigned for the semester)
Windows Server Static IP: 10.161.21.3

Default Gateway: 10.161.21.1
DNS Servers: UNI DNS Servers - 10.120.16.10 and 10.120.16.11

'| Internet Protocel Versien 4 (TCP/IPv4) Properties X |
4 General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(O) Obtain an IP address automatically

(®) Use the following IP address:

1P address: [10.161.21. 3]
Subnet mask: [2s5.255.255. 0 |
Default gateway: [10.161.21. 1 |

Obtain DNS server address automatically

(@) Use the following DNS server addresses:

Preferred DNS server: [10.120.16 . 10 ]
Alternate DNS server: [10.120. 16 . 11 ] -
[]validate settings upan exit Advanced...

[oc ]| come

17



Go to terminal and ping www.google.com to verify network connectivity

B Administrator: Command Prompt

Go to Vsphere Esxi and Install “VMware Tools”

& Windows Server 2022 P2 & & @ | iactons

Summary Monitor Configure Permissions Datastores Networks Snapshots

Mware Tools: Not running, not installed
MORE INFO

LAUNCH WEB CONSOLE

Launch rewore consore @ £ 13 07

WMware Tools is not installed on this virtual machine.

SWITCH TO NEW VIEW

o GE
ST sE
= 25.45 GB

nstall VMware Tools.

Go back to the Windows Server 2022 VM and navigate to File Explorer to open the newly

mounted DVD Drive

I
v = Manage DVD Drive (D) Viware Tools
I“ Home Share View Application Too ﬂ
— ) E »  DWD Drive (D7) VMware Tools
la te Iified
¢ v 3F Quick access
Files Currently on the Disc (8
B Desktop
‘ Downloads Program Files : File folde
ER autorun
Decuments -
autorun 0/3/2023 3:27 Al Se formal
= Pictures
certified 2 [
a This PC manifest
¢4l setup 3 33:27 AM d
’ Ty .
@2 DVD Drive (D:) VMwa 3 setupsd
# Network 1| YMwareToolsUpgrader D/3/2023 3:27

18




VMWare Tools Install: Typical
Once install is complete, restart the System

ﬁ Viware Tools Setup -

Please select a setup type.

(®) Typical
Installs the program features used by this VMware product only. Select
this option if you intend to run this virtual machine only with this
YMware product.

O Complete

Installs all program features, Select this option if you intend to run this
virtual machine on multiple VMware products.

O Custom

Lets you choose which program features to install and where to install
them. Only advanced users should select this option.

< Back Next > Cancel

19



Windows Server Guide

Manage Installed Programs

1. You can access the “Control Panel” program through the Start Menu

2. Navigate to “Programs”

3. Now you can see all of the installed programs and manage them (uninstall, repair,
change, etc.)

[ Programs and Features - a X

« “ 4 [ » ControlPanel » Programs > Programs and Features v | &  SearchPrograms and Features O

Control Panel Home .
Uninstall or change a program

View installed updates To uninstsll a program, select it from the list and then click Uninstall, Change, or Repair.
G Turn Windows features on or

off Organize = =~ 9
Name - Publisher Installed On  Size Version
e Microsoft Edge Microsoft Corporation 2/7/2025 132.0.2957.140
‘ﬁ'Micrusu& Visual C++ 20153-2022 Redistributable (x64)... Microsoft Cerporation 2/6/2025 206MB 1436323320
ﬁMicmsn& Visual C++ 2015-2022 Redistributable (x86)... Microsoft Corporation 2/6/2025 180MB 1436325320
@VMware Tools VMware, Inc, 2/6/2025 102MB  12.3.5.22544099

Show Hidden Files and Directories

Navigate to File Explorer and select “View” on the top bar. After selecting “View”, select the
“Options” module

L = | File Explorer — O X
' Home Share View | - 0'
L
| E (W Preview pane | = Extra large icons [&] Large icons =& Medium icons Group by it s
=2 small icons EFEF List E=Z Details Add columns [] File name extensions
Mavigation i - B= - Sort Hide selected J Options|
pa?m - [[H Details pane :Z Content Z by size all columns to fit  [_] Hidden items FEne p'
Panes Layout Current view Show/hide
J UeskTop UesKop vuwnivaus _ wuoumens [JISUTES
B oo B This PC B ThisPC |45 This PC ) This PC

A popup will appear. Navigate to “View” in the top bar and then select “Show hidden files,
folders, and drives”.

After selection, click “Apply”. Hidden files and folders will now be visible in the File Explorer GUI.
Hidden files and folders will generally appear with less opacity (transparent) while files that

are always visible still appear with full opacity.

Example: ProgramData Folder (now visible)

il M = | Manage Local Disk (C3)
Home Share View Drive Tools
« “ 4 ia > ThisPC > Local Disk (C:) »
Name Date modified Type Size
3¢ Quick access
SWinREAgent File folder
1 Deskiop 9
Perflogs File folder
¥ Dounlozds Pragram Files File folder
5] Documents Pragram Files (x86) File folder
&= Pictures ProgramData File folder
[ This PC Users File folder
Windows File folder

8 DVD Drive (D) S85_X¢

¥ Metwork

20



Windows System

Logs

Launch “Event Viewer” from the Start Menu

Best match

B Event Viewer
- app

H £ event Viewer

Once in the application, you can use the side menu to select from a variety of categories and

view their logs

Q Event Viewer
File Action View Help
= | 5@

{2] Event Viewer (Local) Windows PowerShell  Number of ev... |
2 Custom Views ] ) 0]
i A Windows PowerShell N
a Windows Logs Level Date and Time
v [ Applications and Services Lo/ || (DGR N PER A - EY: = OpenSaved Log...
g.—l Hardware Events @ Information 2/6/2025 T:02:42 F ¥ Create Custom View...
i 6 7.02-
§.—| Internet Explorer @Infurmatfun 2/6/2025 7:02:42 F Import Custom View..
g..—| Key Management Service @ Infermation 2/6/2025 T:02:42 F
I Microsoft (@) Information  2/6/2025 T:02:42 F Clear Log...
| OpenSS5H (i) Information  2/6/2025 7:02:42 F ¥ Filter Current Log...
. [E] Windows PowerShell (D information  2/6/20257:0242F | | (] properties
2 Subscriptions (i) Information  2/6/2025 7:02:42 F 8 Find
(D) Information  2/6/2025 7:02:41 E ine.-
(i) Information  2/6/2025 7:02:40 F Il Save All Events As...
':ﬁ"““'”‘“““" Fie s 7‘”""‘“)" Attach a Task To this Log...
Event 403, PowerShell '3 View
| Refresh
General i
Details Help
~
Engine state is changed from A Event 403, PowerShell (PowerShell)
Details: B Event Properties
2 _CE Attach Task To This Event...
< >
< > Bz Copy v
BDA racilte i BDA racilte |

21



You can click on an individual log (event) and see its exact details

E Event Properties - Event 403, PowerShell (PowerShell)

General  Details
|14

Engine state is changed from Available to Stopped. A

Details:
MNewEngineState=Stopped
PreviousEngineState=Available

SequenceMumber=13 "
Log Mame: Windows PowerShell
Source: PowerShell (PowerShell) Logged: 2/6/2025 T:02:42 PM
Event ID: 403 Task Category:  Engine Lifecycle
Level Informaticn Keywords: Classic
User: N/A Computen: WIN-UOOT4AQTETY
OpCode: Info

More Information:  Event Log Online Help

Copy Close

Windows Services Manager

The Windows Services Manager is a tool that allows you to manage the services running on
your Windows operating system. Services are background processes that perform various

functions, such as networking, security, and system maintenance.

Launch “Services” from the Start Menu to access the Services Manager.

C G Services = [m] X
1 File Action View Help
fi A Best match (e |@ o= HE/ v » o nn
L i Services (Local) || 23" Senvices (Local)
Services 4 : : - ~ o

4] Select an item to view its description. Name Description Status Startup Type Log ™
App 1 {Eh ActiveX Installer (AxInstSV)  Provides Us... Disabled Loc
(CLAlloyn Router Service Routes Alllo... Manual (Trig... Loci
Apps ©) App Readiness Gets apps re... Manual Loc
: . €1 Application Identity Determines ... Manual (Trig... Loc
@ Microsoft Azure Services ‘ChApplication Infermation Facilitates t... Manual (Trig... Loci
. i {6 Application Layer Gateway ... Provides su.. Manual Lac
# Component Services &) Application Management  Processes in... Manual Loc
‘ChAppX Deployment Service (... Provides inf... Manual (Trig... Loci
i Auto Time Zane Updater Automatica... Disabled Lac
Gk Background Intelligent Tran... Transfers fil.. Manual Loc
CkBackground Tasks Infrastruc... Windows in.. Running  Automatic Loc
1€ Base Filtering Engine The BaseFil..  Running  Automatic Loc
Gk Bluetooth Support Service  The Bluetoo... Manual (Trig... Loc
Lk Capability Access Manager... Providesfac.. Running  Manual Loc
1€ CaptureService_9a615¢ Enables opti... Manual Lac
) Certificate Propagation Copies user .. Manual (Trig.. Loci
“CkClient License Service (ClipS... Provides inf... Manual (Trig...  Lec
1€ Clipboard User Service_9a61... Thisuserser.. Running Automatic (..  Loc
CLCNG Key Isolation The CMG ke.. Running  Manual (Trig.. Lec
£5.COM= Event System Supports Sy.. Running  Automatic Loci

£1.COM+ System Application  Manages th.., Running  Manual Loci v
< >

%, Bxtended 4 Standard

22




You can start/stop/restart a service in the Services Manager by selecting or right clicking the
desired service.

-J;} Extensible Authentication P... The Extensi...

Manual Loci

- Running  Manual
L Function Discover : Running  Manual (Trig...  Loci
-.,"’ie?;GEDbCEtiDI"I Servi S Disabled loci |
-..';};Graphicspervac Pause Dizahled Lo
Q};Gmup Pelicy Clier Resume Running  Automatic (T.. Lloci  je
-.,‘;};Human Interface [ Restart Manual (Trig.. Loc
‘5L HV Host Service Manual (Trig... Leci ¥
< All Tasks » >

Refresh

Properties

Help BPA results

You can configure a service to start automatically by navigating to “Properties” after right
clicking. You then can customize the Startup type to “Automatic”.

Lo e e

Function Discovery Provider Host Properties (Local Computer)
General logOn Recovery Dependencies

Service name:  fdPHost

Display name: Function Discovery Provider Host

Descrintion: e FOPHOST service hosts the Function A
esciption Fl:;’ihlsco\rer).I (FD) network discovery providers. These “
F mrmssidare oommhs matun, icmmuans cansinas far
Path to executable:
C:Windows'system32'svchost exe 4 LocalService
Startup type: | Automatic ~

Service status:
Start Stop Pause Resume

You can specify the start parameters that apply when you start the service
from here.

Start parameters:

Concel | [ fonly

x

23



Add/Delete Local Users

Navigate to “Settings” and then the “Accounts” tab. Once in Accounts, select “Other Users”.

(S Settings

4 @ Home

Other users

Find a setting

pel | Other users

Accounts

A= Yourinfo

Q Sign-in options

I R+ Qther users

Add someone else to this PC

+

- ] X

After selecting the “+”, a menu should appear with a “Users” and “Groups” folder in the left bar.

File Action View Help
=5 =)

:k» lusrmgr - [Local Users and Groups (Local)]

1 Users
| Groups

Click on the “Users” folder and then right click to bring up a popup menu to add a “New User”.

I & Local Users and Groups (Lecal) || MName

[ Users
[l Groups

File Action View Help

L ol AR (NERESN 7 Mo

:Eo lusrmgr - [Local Users and Groups (Local)\Users]

&. Local Users and Groups (Local)
| Users
| Groups

MName Full Name

&;Administrator

&Defaultncco...

&Guest

&, WDAG UHility...
Mew User...
Refresh
Export List...
View

Arrange lcons

Line up lcons

Help

Description

Built-in account for adn
A user account manage
Built-in account fer gue
A user account manage

24



You will be prompted to enter information about the new user. Once the user is created it will
show up in the Users directory.

f MNew User 7 e
User name: ‘TESt |
Full name: ‘Test User |
Description: ‘This is atest |
Password: |-------oooo |
Confirm password: |........... |

User must change password at next logon
User cannot change password

Passwaord never expires
[] Account is disabled

Help . Create Close

You can delete a user by right clicking an existing user and selecting “Delete”.

MName Full Mame Description Actions
&ihdministratur Built-in account for adr|| Users
&jDefaultAccu:u... A user account manage Me
&jGuest Built-in account for gue

Test Test User et p ;
&, WDAGUHility.. assword... o
All Tasks ¥

Delete

Rename
Properties

Help



Task Scheduler

Windows has a built-in tool called Task Scheduler. It functions similarly to a crontab where you
can put when and how often you want a script to execute.

Launch “Task Scheduler” from the Start Menu

H
Best match

. Task Scheduler
App

I R taskscheliule

Use the left side menu to see existing Windows Tasks

@ Task Scheduler
File Action View Help

o= mHE

@ Task Scheduler (Local)
~ [ Task Scheduler Library
[ Microsoft

Actions

| Owverview of Task Scheduler -
— ~
1y Youcan use Task
“._.# Schedulerto create
and manage
common tasks that
your computer will
carry out
antnmaticalle at the v
Task Status - J
Sta.. | Last 24 hours ~

Summary: 0 total - 0 running, 0....

Task Name

Last refreshed at 2/10/2025 7:3%:02 PM

Task Scheduler (Local)

BB

Connect to Another Computer...
Create Basic Task...

Create Task...

Import Task...

Display All Running Tasks

Enable All Tasks History

AT Service Account Configuration
View

Refresh

Help
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You can create a new task on the right side menu with “Create Basic Task”

® Task Scheduler

|| (®) Task Scheduler (Local)
v [ Task Scheduler Library
» [ Microsoft

L

= O X

Task Scheduler Summary (Last refreshed: 2/ 1) [F78

Ll

[ Overview of Task Scheduler N

:’"‘T_\‘.I\I You can use Task
Scheduler to create
and manage
common tasks that
your computer will

carry out
antamaticallu at the

[ Task Status N

Sta.. | Last24 hours £

Summary: 0 total - 0 running, 0.

]

Task Mame

v

Last refreshed at 2/10/2023 7:3%:02 PM [

Task Scheduler (Local)

C mputer...
H g Create Basic Task...

View

ﬂ Help

it Create Task...

Import Task...

G| Refresh

[& Display All Running Tasks
&] Enable All Tasks History

AT Service Account Configuration

Add “Task Name” and “Description”

Create Basic Task Wizard

Trigger
Action
Finish

@ Create a Basic Task

Create a Basic Task Use this wizard te quickly schedule a common task. For more advanced options or settings

such as multiple task actions or triggers, use the Create Task command in the Actions pane.

Mame: Test Task

Description: | Add task desciption

here...

< Back Mext = || Cancel
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Add a task “Trigger”

Create a Basic Task When do you want the task to start?
© ooy
Daily
Action L
Start a Program O Monthly
Finizh () Onetime

(O) When the computer starts
() When|log on
() When a specific event is logged

Select when you would like the task to repeat

Create a Basic Tazk

Trigger
Recur every: da}r;
Action

Start a Program
Finish

Select task Action
Create a Basic Task
Trigger What action do you want the task to perfform?

Daily
{® Start a program

Start a Program
Finish

() Send an e-mail (deprecated)

() Display a message (deprecated)

Configure the script you would like to execute

Create a Basic Taszk

Trigger Program,/script:

Daily | CPath\To\¥our\Script
Action
Add arguments (optional):
Finish

Start in (optional):

Start: | 271072025 [E- | | TAL1TPM = | [] Synchronize across time zones

Browse...
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Confirm your new Task

Create a Basic Task
Trigger Name: |
Daily Description: Add task desciption here...
Action
Start a Program
Trigger: |D‘ai|y_' At T:44 PM every day |
Action: |Start a program; C:\Path\To\Your\Script |
[[] Open the Properties dialog for this task when | click Finish
When you click Finish, the new task will be created and added to your Windows schedule.
< Back Cancel

Server Roles

Open Windows Server Manager and go to the top right and select the drop down menu named
“‘Manage”. Then choose “Add Roles and Features”.

Manage Tools View

Add Roles and Features

Remove Roles and Featurss

Add Servers

Create Server Group

Server Manager Properties

Set Installation Type to “Role-based or feature-based installation”

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).

® Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

) Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VD) to create a virtual machine-based
or session-based desktop deployment.
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Select the desired server

Select a server or a virtual hard disk on which to install roles and features.

=
(@ Select a server from the server pool

) Select a virtual hard disk

Server Pool

Filter:

MNarme

WIN-UOT4ACTET9

IP Address Operating System

10.161.21.3

Designate Server Roles. Ex: Web Server (11S)

Before You Begin

Installation Type

Server Selection

Server Roles

Features

Web Server Role (1I5)
Role Services

Confirmation

Select one or more roles to install on the selected server,

Roles

Microsoft Windows Server 2022 Standard

|| Active Directory Certificate Services

[[] Active Directory Domain Services

[[] Active Directory Federation Services

[] Active Directory Lightweight Directory Services
[[] Active Directory Rights Management Services
[ Device Health Attestation

[] DHCP Server

[] DNS Server

[] Fax Server

[m] File and Storage Services (1 of 12 installed)
[] Host Guardian Service

[1 Hyper-v

[ Network Policy and Access Services

[ Print and Document Services

[ Remote Access

[[] Remate Desktop Services

[ Volume Activation Services

[[] Windows Deployment Services

[ Windows Server Update Services

Select desired Features

Before You Begin

Installation Typse

Server Selection

Server Roles

Web Server Role (IIS)
Role Services

Confirmation

Select one or more features to install on the selected server.,

Features

[N NET Framework 3.5 Features

| [m] NET Framework 4.8 Features (2 of 7 installed)
[ Background Intelligent Transfer Service (BITS)

[] BitLocker Drive Encryption

[] BitLocker Netwark Unlock

[ BranchCache

[] Client far NFS

[] Containers

[] Data Center Bridging

[] Direct Play

[] Enhanced Storage

[1 Failover Clustering

[] Group Policy Management

[] Host Guardian Hyper-V Support

|:| 1/0 Quality of Service

[] 115 Hostable Web Core

[1 Internet Printing Client

] Ip Address Management (IPAM) Server

[1 LPR Pert Meniter

Description

Web Server (lIS) provides a reliable,
manageable, and scalable Web
application infrastructure.

Description

NET Framework 3.5 combines the
power of the .NET Framework 2.0
APls with new technologies fer

building applications that offer

appealing user interfaces, protect
your customers' personal identity
information, enable seamless and

secure communication, and provide

the ability to model a range of
business processes.
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Configure Role Services

Before You Begin
Installation Type
Server Szlection
Server Roles
Featuras

Web Server Role (IIS)

Role Services

Confirmation

Confirm and Install

Before You Begin
Installation Type
Server Selection
Server Roles
Feazturas

Web Server Role (IIS)

Role Services

Confirmation

Select the role services to install for Web Server (IIS)

Role services

4
4 Commeon HTTP Features
Default Document
Directory Browsing
HTTP Errors
Static Content
] HTTP Redirection
[] WebDAV Publishing
4 Health and Diagnostics
HTTP Logging
[] Custom Logging
[] Logging Tools
[] ODBC Logging
[] Request Monitor
[] Tracing
4 Performance
Static Content Compression
[] Dynamic Content Compression
4[] Security

Description

'Web Server provides support for
HTML Web sites and optional
support for ASP.MET, ASP, and Web
server extensions. You can use the
Web Server to host an internal or
external Web site or to provide an
environment for developers to
create Web-based applications.

To install the following roles, role services, or features on selected server, click Install.

[[] Restart the destination server automatically if required

Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, click Previous to clear

their check boxes.

Web Server (115)
Management Tools

1IS Management Conscle

Web Server
Common HTTP Features

Default Document
Directory Browsing
HTTP Errors

Static Content

Health and Diagnostics

LT

Export configuration settings
Specify an alternate source path

< Previous

Next >

Install | | Cancel
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Remote Desktop

You can track Remote Desktop (RDP) status by going to “Local Server” in the left side menu.

@ ¥ Server Manager * Local Server

_ i PROPERTIES

For WIN-UDOT4AO1ETS
i Local Server

B Al SErvers

Computer name WIN-UOOT4AQ1ETS
Workgroup WORKGROUP

&§ File and Storage Services P

Micro3gft Defender Firewall Private: On

Remaot nagement nable

Remote Desktop

MIC Teaming Disable

Ethernet( 10.161.21.3, IPv6 enabled

Operating system version Microsoft Windows Server 2022 Standard

Hardware information VWhware, Inc. VMware7 1




Project 3: pfSense Firewall

Below contains steps outlining the configuration of a pfSense firewall for my network cluster.
will be hosted in the WAN and allow me to configure two internal networks: LAN and DMZ. A
DHCP server will be hosted on the LAN for “company workstations” and the DMZ will be
reserved for servers that need to operate in a less secure network environment, such as the

It

Ubuntu and Windows servers. The pfSense firewall will be operating within the WAN under the

static IP Address: 10.161.21.4.

A DMZ (Demilitarized Zone) is a local network that is separate from a business's private LAN.

This isolated network enhances security by allowing external-facing services to communicate
with the open internet while keeping the internal network protected.

VM Configuration

Guest OS: Free BSD 13 or later (64 bit)
Hardware: 2 CPUs, 8 GB RAM, Thin Provision, 3 Network Adapters Use Datastore ISO file
ISO File: pfSense 2.7.2

Final Specifications

Virtual Hardware VM Options

ADD NEW DEVICE ~

> CPU 2 v @
> Memory v GB v
» Hard disk 1 30 GB v
5 SCSI controller O VVMware Paravirtual
s Network adapter 1 SysAdmin021 v Connected
5> Network adapter 2 SysAdmin021 v Connected
s Network adapter 3 SysAdmin021 v Connected
sy CD/DVD drive 1 Datastore 1SO File v Connected
> Video card Specify custom settings v
> Security Devices Not Configured

VMCI device
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pfSense Setup

Network Configuration
e Use “zfs” partitioning
o Select the” VMware Virtual Disk”
e Enter NICs for the WAN, LAN, and DMZ
o WAN =vmx0
o LAN =vmxi1
o Optional 1 (DMZ) = vmx2 OPT1 -> w2

Do you want to

interfaces will be assigned as follows:

(default to 192.168.1.1/24)

WAN Setup

Adapter vmx0

pfSense WAN Address set to: 10.161.21.4/24
WAN Upstream Gateway set to: 10.161.21.1
Set as “Default Gateway”

No IPv6

No DHCP on WAN

DMZ Setup

Adapter vmx2

DMZ Gateway address set to: 192.168.2.1/24
No WAN Usptream Address

No IPv6

No DHCP

Final Configuration:

Reloading routing configuration...
DHCPD. ..

The IPv4 WAN address has been set to 18.161.21.4/24

Press <ENTER> to continue.
UMuware VUirtual Machine - Netgate Device ID: 1d35718f@8c7d1d98a3b5S

=*xx lelcome to pfSense 2.7.2-RELEASE (amd64) on pfSense xxx

HWAN (wan) -> vmx@ -> vd: 18.161.21.4/24
LAN (lan) -> umxl ->vd: 192.168.1.1/24

OPT1 (optl) -> vMx2 -> v4: 192.168.2.1/24

Logout (SSH only) 9) pfTop

Assign Interfaces 18) Filter Logs

Set interface(s) IP address 11) Restart webConfigurator
Reset webConfigurator password 12) PHP shell + pfSense tools
Reset to factory defaults 13) Update from console

Reboot system 14) Enable Secure Shell (sshd)
Halt system 15) Restore recent configuration
Ping host 16) Restart PHP-FPM

Shell
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pfSense Configuration

Navigate to 192.168.1.1 in a browser and sign in
e Default Credentials
e Username: admin
e Password: pfsense

General Information
Hostname: pfSense
Domain: home.arpa

e Primary DNS Server: 10.120.16.10
e Secondary DNS Server: 10.120.16.11
e Override DNS: [/

Time Server (leave default)

WAN Configuration

Wizard / pfSense Setup/ Configure WAN Interface

Step 4 0f 9

Configure WAN Interface

g 0
< C

Bl pfSense - Login X —|—

A Notsecurd | 192.168.1.1

fFisense

On this screen the Wide Area Network information will be configured

SelectedType Static

General configuration

This field can be used to modify ("spoof”) the MAC address of the WAN interface (may be required with some cable connections). Enter a MAC address

Set the MTU of the WAN interface. If this field is left blank, an MTU of 1492 bytes for PPPgoE and 1500 bytes for all other connection types will be

MAC Address
in the following format: xx:xxzocxcxoxx or leave blank.
MTU
assumed
MSS

If a value is entered in this field, then MSS clamping for TCP connections to the value entered above minus 40 (TCP/IP header size) will be in effect. If
this field is left blank, an MSS of 1492 bytes for PPPoE and 1500 bytes for all other connection types will be assumed. This should match the above

MTU value in most all cases

Static IP Configuration

IP Address 10.161.21.4

Subnet Mask 24

Upstream Gateway 10.161.21.1
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Uncheck RFC1918 Networks and Bogon Networks

RFC1918 Networks

Block RFC1918 Private Iock private networks from entering via WAN

Networks PTEn set, this option blocks traffic from IP addresses that are reserved for private networks as per RFC 1918 (10/8, 172.16/12, 192.168/16) as well as

loopback addresses (127/8). This option should generally be left turned on, unless the WAN network lies in such a private address space, too.

Block bogon networks

Block bogon networks Iock non-Internet routed networks from entering via WAN

¥TEn set, this option blocks traffic from IP addresses that are reserved (but not RFC 1918) or not yet assigned by IANA. Bogons are prefixes that
should never appear in the Internet routing table, and obviously should not appear as the source address in any packets received

LAN Configuration

Configure LAN Interface

On this screen the Local Area Network information will be configured.

LAN IP Address 102.168.1.1

Type dhep if this interface uses DHCP to obtain its IP address.

Subnet Mask 24 v

Final System Info:

System Information

pfSense.home.arpa
admin@192.168.1.101 (Local Database)

System VMware Virtual Machine
Netgate Device ID: 1d35710f0c7d1d90a3b5

BIOS Vendor: Phoenix Technologies LTD
Version: 6.00
Release Date: Thu Nov 12 2020

Version 2.7.2-RELEASE (amd64)
built on Wed Dec 6 20:10:00 UTC 2023
FreeBSD 14.0-CURRENT

The system is on the latest version
x|

Version information updated at Fri Feb 14 18:36:28 UTC 2025 g~
CPU Type Intel(R) Xeon(R) CPU E5-2695 v3 @ 2.30GHz

2 CPUs: 2 package(s) x 1 core(s)

AES-NI CPU Crypto: Yes (inactive)

QAT Crypto: No

Hardware erypto Inactive
Kernel PTI Enabled
MDS Mitigation Inactive
Uptime 2 Days 00 Hour 06 Minutes 32 Seconds

Current date/time  Fri Feb 14 18:37:19 UTC 2025

DNS server( « 127.0.01

= 10.120.16.10
= 10.120.76.11

Last config change Fri Feb 14 18:35:38 UTC 2025
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DHCP Setup
Edit the DHCP Server

all - Services ~ VPN ~

Auto Config Backup

Captive Portal

DHCP Rela
- DHCP Server m

DHCPv6 Relay

ie) DHCPv6 Server
DNS Forwarder —_—
= DNS Resolver
Dynamic DNS
IGMP Proxy It you ¢
NTR Comm
hardwi
PPPoE Server the NE

Router Advertisement  You als

SNMP Suppo

A commi
14183

i UPRP & NAT-PMP more i

30GHz Wake-on-LAN . Up

Set DHCP Range: 192.168.1.101 to 192.168.1.254

Subnet 192.168.1.0/24

Subnet Range 192.168.1.1-192.168.1.254

Address Pool Range 192.168.1.101 192.168.1.254

Tom To

The specified range for this pool must not be within the range configured on any other address pool for this interface

Additional Pools 4 Add Address Pool

If additional pools of addresses are needed inside of this subnet outside the above range, they may be specified here.

Configure LAN DNS

WINS Servers

DNS Servers 10.120.16.10

10.120.16.11

REMINDER: Save settings at the bottom of the screen and then Apply Changes at the top

Custom DHCP Options ‘7‘
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Change to OPT1 Interface and rename to DMZ -> Save and Apply Changes

msense Interfaces ~

COMMUNITY EDITION

Assignments

Interfaces / OPT1 (3
WAN

General Configuration LAN
OPT1
Enabq

Description DMZ

Enter a description (name) for the interface here.

Firewall Rules

Navigate to Firewall menu

Firewall ~

Aliases

NAT

| Rules
o

Schedules

Traffic Shaper

[ B

Use the bottom menu to add, delete, edit, and reorder firewall rules.
e NOTE: Order does matter, rules that are higher on the list have more priority

Floating WAN LAN DMZ

Rules (Drag to Change Order)

o States Protocol Source Port Destination Port Gateway Queue Schedule Description Actions

[0 ) (R (S (o
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WAN Firewall Rules

Firewall / Rules/ WAN =)

Floating WAN LAN DMZ

Rules (Drag to Change Order)

(=] States Protocol Source Port  Destination Port  Gateway Queue Schedule Description Actions

ed until pass rulg

B e S R

LAN Firewall Rules
Firewall / Rules/ LAN W = @

Floating WAN LAN DMZ

Rules (Drag to Change Order)

U States Protocol Source Port Destination Port G Queue Schedule Descripti Actions
+ 1/674MB * * * LAN Address 80 * * Anti-Lockout Rule ]
O « 0/08B IPvATCP/UDP  LANsubnets *  DMZsubnets * * none AlowalLouttoomz & L OOM@mX
0 « 5/26KiB IPv4TCP/UDP  LANsubnets *  * 53 (DNS) * none ALLOW DNS OUT S 00mx
0 & 4/151MiB IPv4TCP/UDP LANsubnets *  * 443 (HTTPS)  * none ALLOW HTTPS OUT 4 S00Mmx
O « 0/4KiB IPv4TCP/UDP  LAN subnets *  * 80 (HTTP) * none ALLOW HTTP OUT LS 00mx
O « 0/08B IPv4 ICMP LANsubnets *  * * * none ALLOW PING OUT 3, 00m%
echoreq

DMZ Firewall Rules

Firewall / Rules/ DMZ ER =)
Floating WAN LAN DMZ
—
o States Protocol  Source Port Destination Port Gateway Queue Schedule  Description Actions
O 0/4 KiB IPv4 * DMZ subnets o LAN subnets £ = none REJECT ALL TO LAN & ,00m
O « 0/08B IPva * DMZ subnets * * * * none ALLOW ALL 4, 00mx
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Internal Device Placement

Windows Server (DMZ)

Go into Network and Internet Settings to edit the “Ethernet Adapter”
DMZ Static IP: 192.168.2.2

Internet Protocol Version 4 (TCP/IPvd) Properties X

i
General
h  ‘fou can get IP settings assigned automatically if your network supports
- this capability. Otherwise, you need to ask your network administrator
N for the appropriate IP settings.
iy
B (C) Obtain an IP address automatically
E (@) Use the following IP address:
I 1P address: 192 .188. 2 . 2
§ Subnet mask: 255,255,255, 0
4
m Default gateway: 192 .188. 2 . 1

Obtain DNS server address automatically
(@) Use the following DNS server addresses:

Preferred DNS server: 0 .120, 16 . 10

Alternate DNS server: W .120. 16 . 19

[Jvalidate settings upon exit Advanced. ..

i Cacel

Add a firewall rule to allow inbound pinging of the Windows Server

which this rule applies.

Customize ICMP Settings X

Apply this rule to the following Intemet Cortrol Message Protocol (ICMP)
To which ports and protocols does this rule apply? connections:

O AlICMP types orr
(® Specific ICMP types

[] Packet Too Big

[] Destination Unreachable
[ Source Guench

[ Redirect

[] Echo Request

[ Router Advertisement
Example: 80, 443, 5000-5010 %;‘:ﬂizﬁﬁ:‘;’"
Remote port: All Ports [[] Parameter Problem

[] Timestamp Request ko:
[] Address Mask Request

Protocol type ICMPw4 ~

Protocol number: 1

Local port All Ports

Example: 80, 443, 5000-5010

Intsmet Control Message Protocol

(ICMP) settings n W
This ICMP type
Type 0 w| Code: Any ~ Add
<Bask Cance
Inbound Rules

Mame Group Profile  #

ICMP Echo Request OK All



Ubuntu Server (DMZ)

Change directories to /etc/netplan

Edit the network config file with: sudo nano 50-cloud-init.yaml
DMZ Static IP: 192.168.2.3

Refresh the network: sudo netplan apply

GNU nano 7.2

50-cloud-init.yaml

\ default
ria: 192.168.2.1

Windows Client Setup (LAN)

Creating the following 2 Windows clients will simulate workstations in my company. They will be
positioned in the LAN and the pfSense DHCP server should automatically issue out individual
network configurations.

Window for Local A nts (No Microsoft Email R ir
1. ldisconnected the VM network card once each computer was in the final “windows
setup” mode.

2. | then ran the following commands to bypass the required network setup so that | could
create local system accounts:
a. Shift +f10 -> Brings up a command prompt
b. Command: OOBE\BYPASSNRO (Out Of Box Experience command)
3. Once through setup without internet, reconnect the network adapter!

Windows 11 Workstation-01
Username: Bill

Password: **Classified**

Windows 11 Workstation-02
Username: Fernando
Password: **Classified™*

NOTE: “Bob” is the answer for all security questions!!!
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Project 4: Internal Caching DNS

Below contains steps outlining the configuration of an internal caching DNS server on my
pfSense firewall which already manages DHCP. The internal DNS server will allow connected
machines to have fast internet access due to IP caching. Additionally, its integration with the
existing DHCP service will automatically configure DNS settings for LAN clients.

The DNS Resolver service within pfSense is easily integrated with the DHCP server. Having
pfSense manage both allows clients connecting to the LAN to be issued an IP and the internal
caching server simultaneously. The internal caching server also allows configuration of “static
IPs” within the LAN for specific use cases. The IP address of the internal caching DNS Server is
192.168.1.1. Since the DNS server is hosted on the firewall, DMZ clients can access it through
the DMZ gateway address, which is 192.168.2.1. This setup is beneficial as it allows the firewall
to maintain a REJECT ALL traffic rule from the DMZ to the LAN.

DNS Resolver Configuration

To configure the internal DNS Resolver (Unbound) navigate to Services > DNS Resolver

'sense System ~ Interfaces ~ Firewall =~ Services ~ VPN ~

COMMUNITY EDITION

Auto Config Backup

Status / Dashboard Captive Portal
DHCP Relay
System Information DHCP Server m
Name pfSense home.arpa DHCPv6 Relay ]
User admin@192.168.1.102 (Local Database) DHCPV6 Server
System VMware Virtual Machine DNS Forwarder
Netgate Device ID: 1d35710f0c7d1d90a3b5 DNS Resolver
BIOS Vendor: Phoenix Technologies LTD Dynamic DNS m
Version: 6.00 .-!-. Wi
Release Date: Thu Nov 12 2020 IGMP Proxy
2 A
Version 2.7.2-RELEASE (amd64) NTP £
built on Wed Dec 6 20:10:00 UTC 2023 PPPoE Server 15200

FreeBSD 14.0-CURRENT
Router Advertisement

t SNMP

Version information updated at Wed Feb 26 1¢
- UPnP & NAT-PMP
~

Wake-on-LAN

Enable the DNS Resolver

Keep all ports default (Port 53)

Set Network Interfaces and Outgoing Network Interfaces to “All”
Disable DNSSEC (does not integrate well with UNI DNS Servers)

Enable DNS Query Forwarding, DHCP Registration, Static DHCP
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Add “Host Overrides” at the bottom of the page for the LAN and DMZ

e This will allow the LAN and DMZ to fetch a hostname for the firewall for whichever
gateway is being used by the client.
Parent domain of host IP to return for host Description Actions
192.168.1.1 pfSense LAN DNS P
pfSense DMZ DNS gateway Pl

pfsense
slick.firewall

Host
slick firewall
192.168.2.1
should be overridden and a specific IPv4 or IPv6 address should automatically be returned by the

pfsense-dmz
resolver. Standard and also non-standard names and parent domains can be entered, such as test’, 'nas.home.arpa’, ‘mycompany.localdomain|, '1.168.192.in-addr.arpa), or

LAN: pfsense.slick.firewall
pfsense

Host
Name of the host, without the domain part
e.g. enter "myhost" if the full domain name is "myhost.example.com

slick firewall

Parent domain of the host

Domain
e.g. enter "example.com” for "myhost.example.com”

IP Address 192.168.1.1
IPv4 or IPv6 comma-separated addresses to be returned for the host

8.100.100 or fd00:abed:

eg.: 19
or list 192.168.1.3,192.168.4.5,fc00:123::3

Description pfSense LAN DNS
A description may be entered here for administrative reference (not parsed)
DMZ: pfsense-dmz.slick.firewall
Host Override Options
Host | pfsense-dmz
Name of the host, without the domain part
e.g. enter "myhost" if the full domain name is "myhost.example.com
Domain slick firewall
Parent domain of the host
e.g. enter "example.com’ for "myhost.example.com’
IP Address 102.168.2.1
IPv4 or IPv6 comma-separated addresses to be returned for the host

e.g.: 192.168.100.100 or fd00:abcd
or list 192.168.1.3,192.168.4.5,fc00:123::3

pfSense DMZ DNS gateway
A description may be entered here for administrative reference (not parsed)

Description

Enter any individual hosts for which the resolver's standard DNS lookup proce
'somesite.com’. Any lookup attempt for the host will automatically return the given IP address, and the usual lookup server for the domain will not be queried for the host's records
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DHCP Configuration

To configure DHCP navigate to Services > DHCP Server
Then make sure you are on the LAN tab.
Flisense

MUNITY EDITION

Services ~

Auto Config Backup

Services/ DHCP Server / LAN Captive Portal
DHCP Relay

SC DHCP has reached e e e remave Ut tem =
DHCPv6 Relay
DHCPv6 Server

WAN LAN DMZ
DNS Forwarder

—

DNS Resolver

General DHCP Options .
Dynamic DNS

DHCP Backend ISC DHCP IGMP Proxy
NTP
Enable Enable DHCP server on LAN imey
PPPoE Server

BOOTP Ignore BOOTP queries Router Advertisement

Deny Unknown Clients Allow all clients SNMP

UPnP & NATPMP

When set to Allow all clients
interface, any DHCP client with
clients from only this interface, on

Wake-on-LAN

Ensure DHCP is enabled on LAN

DHCP Backend ISC DHCP

| Enable Enable DHCP server on LAN interface |
BOOTP Ignore BOOTP queries
Deny Unknown Clients Allow all cliemts v

Whe o Allow all clients, a lients from any

interface, any DHCP client v Allow known

clients from only this interfac

range

Ignore Denied Clients Ignore denied clients rather than reject
This option is not compatible with failover and cannot be enabled when a Failover Peer IP address is configured,
Ignore Client Identifiers Do not record a unique identifier (UID) in client lease data if present in the client DHCP request

n a client dual boot using different client identifiers but the same hardware (MAC) ad t the resulting

n may be usefi

ial DHCP spec

avior violat

Ensure primary address pool is within the LAN subnet

Primary Address Pool

Subnet 192.168.1.0/24

Subnet Range 192.168.1.1-192.168.1.254

Address Pool Range 192.168.1.101 192.168.1.254
From To
The specified range for this pool must not be within the range configured on any other address pool for this interface.

Configure the DHCP issued DNS Server to be the internal caching server: 192.168.1

Server Options

WINS Servers

DNS Servers 192.168.1.1




System Configuration

To ensure requests are forwarded from the internal caching server to the local recursive DNS
servers navigate to System > General Setup

mSEnse System «

COMMUNITY EDITION

Advanced
Status/ [ cenicates

General Setup

D ARl tiih Availability -

Name Package Manager

User Register 22 (Loci

System Routing fhine
Setup Wizard peno

BIOS Update hnologi
User Manager w122

T Logout (admin) 164)

Ensure your Local Recursive DNS servers are properly configured
In this case | have the UNI DNS Servers: 10.120.16.10 and 10.120.16.11

DNS Server Settings

DNS Servers

ostname for TLS Verifi n i
€, nal)
Add DNS Server + Add DNS S
DNS Server Override Allow DNS server list to be overridden by DHCP/PPP on WAN or remote OpenVPN server

DNS Resolution Behavior

r or Forwarder) as the first DNS server when possible, and it will fall back to
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Ubuntu DNS Config

To connect the Ubuntu server statically set to 192.168.2.3 in the DMZ to the internal DNS
hosted by the pfSense firewall do the following:

Edit the netplan file: sudo nano /etc/netplan/50-cloud-init.yaml

Replace the current name server addresses with 192.168.2.1

Since the server is on the firewall, the DMZ gateway address should allow the server to utilize
the internal DNS Resolver that was configured.

Refresh the network with the command: sudo netplan apply

Test your name server with the command: resolvectl status
It should output the internal caching DNS IP which is pfsense-dmz.slick.firewall:192.168.1.1
@boontooboiserver:/etc/netplan® resolvectl status

-LLMNR -mDNS -DNSOverTLS DNSSEC=no/unsupportecd
stub

Link 2 (ens19z)

tRoutesLLMNE -mDNS -DNSOverTLS DNSSEC=nosunsupported

ver:/etc/netplan$ nslookup google.com

U :

Address:

Hame :

Address :f8be:4069:81c::

46



Windows DNS Config

To connect the Windows server statically set to 192.168.2.2 in the DMZ to the internal DNS
hosted by the pfSense firewall do the following:

Navigate to edit the server’s ethernet connection

-E' Netwerk Connections
™ ﬁ-' » Control Panel » Network and Internet » Network Connections

Organize v

"'- Ethernet(
>  Network 3
@ET |ntel(R) 82574L Gigabit Network C..

Edit the “Properties” of the adapter and then select “Internet Protocol Version 4”

of

W Etf U Ethernet0 Properties X
General Networking
Connection Connect using
Pv4 Connectivity: & Intel(R) 82574L Gigabit Network Connection
Pv6 Connectivity:
Media State: Configure....
Duration: This connection uses the following items:
Speed: B3 lient for Microsoft Networks N
3 File and Prirter Sharing for Microsoft Networks
] %8QoS Packet Scheduler
Intemet Protocal Version 4 (TCP/IPv4)
Microsoft Network Adapter Muttiplexor Protocal
Activity & Microsoft LLDP Protocol Driver

1. Intemet Protocol Version & (TCP/IPv6) v
t < >
Install... Uninstall Properties

Bytes: 75,910,
Description
Transmission Control Protocol/intemet Protocol. The default
& Properties €Disab| wide area network protocol that provides communication
across diverse interconnected networks.

0K Cancel

Set the “Preferred DNS server” to 192.168.2.1

Internet Protocol Version 4 (TCP/IPvd) Properties XTI
General

You can get IP settings assigned automatically if your network supports

this capability. Otherwise, you need to ask your network administrator

for the appropriate IP settings. I
(O Obtain an IP address automatically
(®) Use the following IP address:

IP address: 192.168. 2 . 2 |
Subnet mask: 255.255.255. 0

Default gateway: 192.168, 2 . 1

o Obtain DNS server address automatically

(®) Use the following DNS server addresses:

! I Preferred DNS server: 92.168. 2 . 1 | I
Alternate DNS server: g 3 % I
b
[ validate settings upon exit Advanced...

* o] e




Test your name server with the command: nslookup
It should output the internal caching DNS IP which is pfsense-dmz.slick.firewall:192.168.1.1

EX Administrator: Windows PowerShell

C:\Users\Administrator> nslookup
Fault Se pfsense-dmz.slick.firewall

Address:

nslookup google
ck.firewall

Non-authoritative an
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LAN Client Testing

If you properly configured the internal caching DNS server, you should be able to do the
following in a terminal from a LAN machine:

Test the functionality and verify the DNS Server is the correct address with the command:
nslookup google.com

The DNS Address came back as 192.168.1.1 which is perfect because that is what was
configured!

PS C:\Users\Bill> nslookup google.com
Server: pfSense.slick.firewall
Address: 192.168.1.1

Non-authoritative answer:

Name : google.com

Addresses: 2607:f8b0:U009:819::200e
142.250.191.174

Test caching with the dig command: dig mlb.com

Run the command twice. The first query should be much longer than the second!
PS C:\Users\Bill> dig mlb.com

; <<>> DiG 9.16.28 <<>> mlb.com

;i global options: +cmd

++ Got answer:

++ —>>HEADER<<- opcode: QUERY, status: NOERROR, id: 51152

;7 flags: qr rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: ©, ADDITIONAL:

++ OPT PSEUDOSECTION:

; EDNS: version: O, flags:; udp: 1432
;; QUESTION SECTION:

;mlb.com. IN

+ 7 ANSWER SECTION:
mlb.com .182.163.158

7+ Query time: 15 msec

7; SERVER: 192.168.1.1#53(192.168.1.1)

;7 WHEN: Wed Mar 85 17:33:47 Pacific Standard Time
7+ MSG SIZE rcvd: 52

PS C:\Users\Bill> dig mlb.com

; <<>> DiG 9.16.28 <<>> mlb.com

;i global options: +cmd

;+ Got answer:

++ —>>HEADER<<- opcode: QUERY, status: NOERROR, id: 23439

;i flags: gqr rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: ©, ADDITIONAL: 1

++ OPT PSEUDOSECTION:

; EDNS: version: @, flags:; udp: 1432
;; QUESTION SECTION:

;mlb.com. IN

7+ ANSWER SECTION:
mlb.com. 34.102.163.158

7+ Query time: © msec

7; SERVER: 192.168.1.1#53(192.168.1.1)

;7 WHEN: Wed Mar 95 17:33:58 Pacific Standard Time
7+ MSG SIZE rcvd: 52
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Project 5: External DNS

Below contains steps outlining the configuration of an external DNS server. The external DNS
server will be hosted on the Ubuntu Server using BIND. This server will respond to queries on
the public and private side of the firewall and will resolve requests made to the two servers in
the DMZ (Windows and Ubuntu). Within the BIND configuration, FQDNs will be created and
mapped to each DMZ server. Doing this will allow clients to query the DMZ servers by a domain
name such as “www.mywebsite.com” instead of by IP address.

DNS Information
pfSense firewall: 10.161.21.4

FQDN Mappings:
www.slickbrickcentral.com -> 192.168.2.3
ubuntu.slickbrickcentral.com -> 192.168.2.3
win.slickbrickcentral.com -> 192.168.2.2

Ubuntu DNS Server

BIND (Berkeley Internet Name Domain) is a software that maps FQDNs (Fully Qualified Domain
Names) to IP addresses. It is open source and can be configured to serve as an authoritative
DNS server, a caching DNS server, or both. A local authoritative DNS server will be hosted
under the static DMZ IP address: 192.168.2.3.

BIND Installation

Run the following commands to install BIND:
1. sudo apt update
2. sudo apt install bind9 bind9utils bind9-doc

Configure BIND to use IPv4 protocol: sudo nano /etc/default/named
Add -4 to the end of the OPTIONS parameter:

GNU nano 7.2 Jetc/default/named *

i S0 1y i
RESOLVCOMF=n0O

I:|F'TI:'.1'_-{:I”—I_J bind -4-

Restart BIND to implement the changes: sudo systemctl restart bind9
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BIND Configuration

Main Configuration File: named.conf.options
Open the config file: sudo nano /etc/bind/named.conf.options

If you want to forward unknown queries, uncomment and update the “forwarders” section with
your DNS servers: UNI DNS Servers: 10.120.16.10 and 10.120.16.11.

GNU nano 7.2
options §

/etc/bind/named.conf.options *x

I however do NOT want to forward queries. | want BIND to resolve only mappings |
configure locally!

Add the following lines to disable forwarding

GNU nano 7.2
options §

setc/bind/named.conf.options

isten-on-ve { any; i;
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Additional lines for logging in a new section below “options”

category security query

Access logs with the command: sudo tail -f /var/cache/bind/named.log
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DNS Zones

Edit the local configuration file to define your DNS Zones:
sudo nano /etc/bind/named.conf.local

This file specifies the DNS zones that BIND will manage.

| will be using slickbrickcentral.com as my company domain (you can change this out).
Also, since the DNS is in the DMZ subnet (192.168.2.0/24), | will use 2.168.192 in the second
zone designation!

GNU nano 7.2

/etc/bindsnamed. conf. local =*

o any local configuration here

18 zones here, If they are not used in your

es.rfc1918";

Create the forward lookup zone file: sudo nano /etc/bind/db.slickbrickcentral.com

This file maps domain names to IP addresses.
Add the following content to the newly created file:

GHU nano 7.2 setcsbindsdb.slickbrickcentral.com x
EB4E08
IN S0R .slic i : . admin.slickbrick

@
nsi1
]
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Reverse Lookup Zone
Create the reverse lookup zone file: sudo nano /etc/bind/db.192

This file maps IP addresses back to domain names.
Add the following content to the newly created file:

GHU nano 7.2 Jetc/bindsdb, 192 *
cad4868
IN S0A ns1.slickbr ntral.com. admin.slickbrickcentral.com.

Check for Errors

Check the config files for syntax errors:

sudo named-checkconf

sudo named-checkzone slickbrickcentral.com /etc/bind/db.slickbrickcentral.com
sudo named-checkzone 2.168.192.in-addr.arpa /etc/bind/db.192

If there are no errors the command output should be as follows:
> slickbrickcentral.com setc/bind/db.slickbrickcentral.con

.in-addr.arpa setc/bindsdb. 192

Restart BIND9 to apply changes: sudo systemctl restart bind9
Configure UFW to allow DNS traffic (if applicable): sudo ufw allow Bind9

Test DNS with a dig command: dig @localhost www.slickbrickcentral.com
onelessone@boontooboiserver: /etc/netplan® dig @localhost www.slickbrickecentral.com
0iG 9.18.36-dubuntu.24.084.2-Ubuntu << glocalhost www.slickbrickcentral.com
 found)
: +Cmd

opr le: Ql =tat N v, id: 42
r aa rd ras; QUE , F H JTHORITY: @, ADDITIONAL: 1

;; QUESTIO

-',|.||||||||_ i |-||' ickcentral.com.

33 ANSk CTION:

W, S ckcentral.com.

3lhost) (UDPY
15 UTC 2025 )




FQDN Records

To add FQDN records for the two static DMZ machines, we will have to update the forward and
reverse zone files!

Update Forward Zone
Edit the forward lookup zone file: sudo nano /etc/bind/db.slickbrickcentral.com

Add A record for the machines:
Ubuntu Server
e FQDN = ubuntu.slickbrickcentral.com
e |P:192.168.2.3
Windows Server 2022
e FQDN = win.slickbrickcentral.com
o |P:192.168.2.2

The file should look like this:
GNU nano 7.2

BEB4866

/etc/bindsdb.slickbrickcentral.com

IN S0 g entral.com. admin.slickbrickcentral.com. (

U]
nsl
]
ubuntu
win

Update Reverse Zone
Edit the reverse lookup zone file: sudo nano /etc/bind/db.192

Add PTR (Pointer) records for the machines:
Ubuntu Server
e FQDN = ubuntu.slickbrickcentral.com
e [P:192.168.2.3
Windows Server 2022
e FQDN = win.slickbrickcentral.com
e [P:192.168.2.2

NOTE: Add the last octet of the IP to the first entry in each PTR record!
For example: 192.168.2.55 —- 55 IN PTR vyay.slickbrickcentral.com
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The file should look like this:
GNU nano 7.2

BR4866
IMN all nsl.slickbrickcentral.com. admin.slickbrickcentral.com. [

fetcsbindsdb, 192 %

e

1.? Cache TTL

tral.com.

tral,com,
arickcentral.com.

ickcentral.com.

Check the config files for syntax errors:

sudo named-checkconf

sudo named-checkzone slickbrickcentral.com /etc/bind/db.slickbrickcentral.com
sudo named-checkzone 2.168.192.in-addr.arpa /etc/bind/db.192

Restart BIND9 to apply changes: sudo systemctl restart bind9
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pfSense Integration

In order to have your caching DNS server hosted on the pfSense firewall forward to the local
DNS you just created, you need to configure pfSense to forward requests to 192.168.2.3 for
your custom domain: slickbrickcentral.com.

Do this by going to the pfSense browser portal: https://192.168.1.1

Navigate to Services > DNS Resolver in the top bar and scroll to the bottom of the page.

msense System ~ Interfaces ~ Services ~

COMMUNITY EDITION

Auto Config Backup
Services / DNS Resolver / General Setting captive Portal

DHCP Relay

DHCP Server

DHCPv6 Relay

DHCPv6 Server

General Settings Advanced Settings Access Lists
DNS Forwarder

DNS Resolver

Dynamic DNS

General DNS Resolver Options

Next, locate “Domain Overrides” at the bottom of the page.

You will need to add 2 records so your local FQDNs will resolve. One record will be the forward
lookup zone and the other will be the reverse lookup zone.

Referencing the earlier DNS configuration:
Forward Zone:

e slickbrickcentral.com

e 192.168.2.3
Reverse Zone:

e 2.168.192.in-addr.apra.

e 192.168.2.3

Add both rules:

Domain Lookup Server IP Address Description Actions
slickbrickcentral.com 192.168.2.3 Forward all DNS requests for slickbrickcentral.com to external DNS Vi
2.168.192.in-addr.arpa. 192.168.2.3 Reverse Lookup Zone for slickbrickcentral.com on Ubuntu Server p‘ ﬁ

ain (including all of its subdomains), a

y for each, using the same domain name

Note: Make sure to select Apply Changes on the top of the page to lock in your changes. Then
refresh the DNS Resolver service —

Services / DNS Resolver / General Settings i & @

Visit System > Advanced > Networking to swit CcP i 57


https://192.168.1.1

Test the Domain Overrides by using a LAN Client to ping, nslookup, and dig one of the FQDNs
you created.

| will test win.slickbrickcentral.com -> 192.168.2.2

Run the command: ping win.slickbrickcentral.com
PS C:\Users\Bill> ping win.slickbrickcentral.com

Pinging win.slickbrickcentral.com [192.168.2.2] with 32 bytes of data:
Reply from 192.168.2.2: bytes=32 time<lms TTL=127
Reply from 192.168.2.2: bytes=32 time<lms TTL=127
Reply from 192.168.2.2: bytes=32 time<lms TTL=127
Reply from 192.168.2.2: bytes=32 time<lms TTL=127

Ping statistics for 192.168.2.2:

Packets: Sent = U, Received = U, Lost = @ (8% loss),
Approximate round trip times in milli-seconds:

Minimum = Oms, Maximum = Bms, Average = Oms

Run the command: nslookup win.slickbrickcentral.com

PS C:\Users\Bill> nslookup win.slickbrickcentral.com
Server: pfSense.slick.firewall
Address: 192.168.1.1

Non-authoritative answer:
Name : win.slickbrickcentral.com
Address: 192.168.2.2

Run the command: dig win.slickbrickcentral.com
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WAN Configuration

VM Configuration

REMEMBER: Thin Provision Storage and TPM Module!!!

Edit Settings

Virtual Hardware VM Options

Encryption
» CPU
> Memory
> Hard disk 1
y SCSI controller O
s Network adapter 1
s CD/DVD drive 1
s USB xHCI controller
> Video card
» Security Devices

VMCI device

Windows 11 Workstation-WAN (Rebecca) X

ADD NEW DEVICE v

VM configuration files are encrypted. (@
60 GB ~

LSI Logic SAS

SysAdmin021 Connected

Datastore ISO File v Connected
USB 3.1
Specify custom settings v

TPM

Windows Setup for Local Accounts (No Microsoft Email Required):

1. ldisconnected the VM network card once each computer was in the final “windows

setup” mode.

2. | then ran the following commands to bypass the required network setup so that | could
create local system accounts:
a. Shift +f10 -> Brings up a command prompt
b. Command: OOBE\BYPASSNRO (Out Of Box Experience command)
3. Once through setup without internet, reconnect the network adapter!

Windows 11 Workstation-WAN

Username: Rebecca
Password: **Classified**

NOTE: “Bob” is the answer for all security questions!!!
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Workstation Network Configuration

Workstation IP: 10.161.21.20
DNS Servers: 10.161.21.4 and 10.120.16.10

Internet Protocol Version 4 (TCR/IPvd) Properties K

General

‘fou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
D Use the following IP address:

IP address: | 1 .161.21.20
Subnet mask: | 255.255.255. 0 |
Default gateway: | 10 .161.21. 1 |

Obtain DN5 server address automatically
0 Use the following DNS server addresses:

Preferred DNS server: | 10 .161. 21 . 4 |

Alternate DNS server: [0 .120. 16 . 10 |

[ validate settings upon exit Advanced...

| also installed the Chocolatey package manager and the dig command.
Powershell: choco install bind-toolsonly

pfSense Address (WAN): 10.161.21.4

| am going to forward any request from WAN to pfSense on port 53 straight to my “external DNS
server”: 192.168.2.3 which then will reply back to the WAN client.
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pfSense NAT
In the admin web interface: http://192.168.1.1

Navigate to Interfaces > WAN. Scroll to the bottom of the page and make sure that “Block

private networks” is unchecked!

Reserved Networks

Block private networks ]
and loopback addresses

rved for private networks per RFC 1918 (10/8, 172.16/12, 192.168/16) and unique local addresses per
sides in such a

sses that are

s loopback ad ses (127/8). This option should generally be turned on, unless this network interface

Block bogon networks ]

es (but not RFC 1

as the source add

Blocks traffic from reserved IP add

and so should not ap,

cal interfaces and it can potentially block required local traffic

This option
Note: The upda

ould only be used on external interfaces (WANSs), it is not ne

requency can hanged under System > Advanced, Firewall & NAT settings

Navigate to System > Advanced > Firewall and NAT Tab.
Flisense

COMMUNITY EDITION

System/ Advanced / Firewall & NAT

Admin Access Firewall & NAT Networking Miscellaneous System Tunables Notifications

In the “Network Address Translation” section further down the page:
o Set “NAT Reflection Mode for Port Forwards” to Pure NAT
e Enable (Check the box) for “Enable NAT Reflection for 1:1 NAT”

Network Address Translation

NAT Reflection mode for Pure NAT v
port forwards

s The Pure NAT mode uses a set of NAT rules to direct g

—_— - —_— 4l the target at the time the rules are loaded. There are no inhe

limits to the number of ports other than the limits of the protocols. All proto avail ards are supported
+ The NAT + Proxy mode uses a helper program to send packets t ful in setups where the interface and/or
gateway IP used for co

IPv6. Only TCP and UDP protocols are

Individual rules may be configured to override this system setting on a per-rule basis

Reflection Timeout

Enter value for Reflection timeout in secon
ort forwards in NAT + proxy mode.

Note: Only applies to Reflection on

Enable NAT Reflection for Automatic creation of additional NAT redirect rules from within the internal networks.
TINAT  note: Reflection on 1:1 mappings is only for the inbound component of the 1:1 mappings. This fuhctions the same as the pure NAT mode for port
O TS T OT TITOTE UETaTS, Te e 10 TTe PUTe oA T TTTo0e UeSeTI o Suove. Tt Tores Ty Be configured to override this system setting on a per-
rule basis.
Enable automatic ~) Automatic create outbound NAT rules that direct traffic back out to the same subnet it originated from.
outbound NAT for ired for full functionality of the pure NAT mode of NAT Reflection for port rds or NAT Reflection for 1:1 NAT. Note: This only works fér
Reflection  5q5igned interfaces. Other interfaces require manually creating the outbound NAT rules that direct the reply packets back through the r
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NAT Port Forwarding Rule
Navigate to Firewall > NAT > Port Forward Tab.

Firewall / NAT / Port Forward (>}
Port Forward 11 Outbound NPt
o Interface Protocol Source Address Source Ports Dest. Address Dest. Ports NATIP NAT Ports Description Actions

[ O 3 X

Add a new Rule with following configurations:

Interface: WAN

Protocol: TCP/UDP

Destination: WAN Address

Destination Port Range: DNS (Port 53 Only)

Redirect Target IP: Internal DNS Server (BIND) — 192.168.2.3
Redirect Target Port: DNS (Port 53)

Interface v
Cho

which interface this rule applies to. In most cases "WAN" is specified

Address Family v

Select the Internet Protocol version this rule applies 1o

Protoco v
Cho

vhich protocol this rule should match. In most cases "“TCP" is specified

ol -

Destination [ Invert match WAN address ¥ / g
Type Address/mask
Destination port range DNS v DNS v
From port Customn To port Custom
Specify the port or port range for the destination of the packet for this mapping. The ‘1o field may be left empty if only mapping a single port
Redirect target IP Address or Alias w 192168.2.3
Type Address

s of the server on which to map the ports. e.g.: 192.168.1.12 for IPv4

Enter the internal IP a

in must be from

sible to redirect from link-ic ses scope (feB0:*) to local scope

v

Redirect target port DNS

Port Custom

Specify the port on the machine with the IP address emtered above. In case of a port range, specify the beginning port of the range (the end port will be

calculated automatically)

This is usually identical to the "From port® above.
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Final NAT Rule:

Port Forward 11 Outbound NPt
| Interface  Protocol Source Address Source Ports Dest. Address Dest. Ports NATIP MAT Ports Description Actions
0 ¢ 34 waN TCP/UDP  * . WAN address 53 (DNS) 19216823 53 (DNS) UM

1 o | oo 8
Corresponding Firewall Rule Created:
Firewall / Rules/ WAN B @

Floating WAN LAN DMZ

Rules (Drag to Change Order)

=] States Protocol Source  Port Destination Port Gateway Queue  Schedule Description Actions

v  0/164KB  IPv4 TCP/UDP . . 192.168.2.3 53(DNS)  * none NAT $/00m

i £ (2 O I CX



WAN Client Testing
Go to the WAN Client (10.161.21.20) created earlier and use the dig command to verify proper

con

First, we will show that DNS requests are properly being port forwarded from pfSense
(10.161.21.4) to FQDNs mapped in the local BIND server (192.168.2.3).

figuration and local DNS resolution.

Run the command: dig win.slickbrickcentral.com

PS

+ £
'

i
i E
=
Y

wil

i

win

C:\Users\Rebecca> dig win.slickbrickcentral.com

<>> DiG 9.16.28 <<>> win.slickbrickcentral.com

; global options: +cmd

: Got answer:

; —>>HEADER<<- opcode: QUERY, status: NOERROR, id: 63556

; flags: qr aa rd; QUERY: 1, ANSWER: 1, AUTHORITY: ©, ADDITIONAL:
; WARNING: recursion requested but not available

OPT PSEUDOSECTION:

DNS: version: @, flags:; udp: 1232

OOKIE: Bd0lc3e3U76cc95c010000PO67elcB83aab1286U0bBd5U5T7e (good)
QUESTION SECTION:

n.slickbrickecentral.com. IN A

ANSWER SECTION:
.slickbrickcentral.com. 684880 IN 192.168.2.2

: Query time: O msec

; SERVER: 10.161.21.u#53(10.161.21.4)

; WHEN: FMon Mar 20 1I0:91:06 Pacific Daylight Time 2025
: MSG SIZE rcvd: 98

As you can see above, the A record for win.slickbrickcentral.com is 192.168.2.2 which is

correct!

Next, we will show that requests NOT mapped in the BIND server are redirected to the alternate
UNI DNS (10.120.16.10) configured on the WAN Machine.

Run the command: dig google.com

PS

: <

C:\Users\Rebecca> dig www.google.com

<>> DiG 9.16.28 <<>> www.google.com

; global options: +cmd
; Got answer:
; —>>HEADER<<- opcode: QUERY, status: NOERROR, id: 64239

; flags: gqr rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: ©, ADDITIONAL:

i
i E

(N}

OPT PSEUDOSECTION:
DNS: version: @, flags:; udp: 4000
QUESTION SECTION:

;www.google.com.

e

ANSWER SECTION:

www .google.com. B 142.250.191.132

e
e
e

e

Query time: © msec

SERVER: 10.120.16.10#53(10.120.16.10)

WHEN: Mon Mar 24 16:42:29 Pacitic Daylight Time 2025
MSG SIZE rcvd: 59
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Project 6: Static HTTPS Web Server

Below contains steps outlining the configuration of a static HTTPS server using Apache on the
existing Ubuntu Linux server (192.168.2.3) within the local DMZ. This server will server static
HTML content to the frontend so no scripting language or database will be needed. Proper
configuration of DNS records, a self signed certificate for SSL connections, and integration of
NAT port forwarding in pfSense will allow clients in the LAN and WAN to access the web
server.

Web Server mapping:
slickbrickcentral.com and www.slickbrickcentral.com — 192.168.2.3 (Ubuntu Linux Server)

BIND DNS Records

Edit the forward lookup zone to add A records for slickbrickcentral.com.
Edit the configuration file: sudo nano /etc/bind/db.slickbrickcentral.com

Add the following A Records:

GNU nano /etcsbinds/db.slickbrickcentral.com x

entral.com. admin.slickbrickcentral.com. (

@

nsl
]
ubuntu
win
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Next update the reverse lookup zone.
Edit the configuration file: sudo nano /etc/bind/db.192

Add the following reverse lookup records:

GNU nano 7.2 /etc/bind/db. 192 x

1.slickbrickcentral.com. admin.slickbrickcentral.com. (
;o Serial

1.slickbrickcentral.com.
ickhrickcentral com.

Apply changes with the command: sudo systemctl restart bind9

Verify Records on WAN Client

Run the command: nslookup slickbrickcentral.com
Run the command: nslookup 192.168.2.3

PS C:\Users\Rebecca> nslookup slickbrickcentral.com
Server: UnKnown
Address: 10.161.21.4

Name : slickbrickcentral.com
Addresses: 10.161.21.4
192.168.2.3

PS C:\Users\Rebecca> nslookup 192.168.2.3
Server: UnKnown
Address: 10.161.21.4

Name : slickbrickecentral.com
Address: 192.168.2.3
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Apache Web Server

The Apache HTTP Server, commonly known as Apache, is a powerful, open-source web
server software that allows websites to be hosted and served over the internet. It is highly
customizable and supports a wide range of features, including SSL/TLS encryption, URL

redirection, and load balancing.

Install and Configuration

I will be installing Apache on the Ubuntu Linux Server in the DMZ under the IP 192.168.2.3.

Update system packages with: sudo apt update

To begin the installation run the command: sudo apt install apache2
Start the service with the command: sudo systemctl status apache2
Verify that it is running with the command: sudo systemctl status apache2

ntoobois ~17% sudo sys ctl star

from

from ubuntue, 1)
from i . 1ubt 1)

f Z-1ubuntul)

Since the Ubuntu Server is within the DMZ, verify the website is being hosted |ocally by using a

DMZ client and navigating to http://192.168.2.3 in a browser.

Y Apache2 Ubuntu Default Page: It X
g

« C A Notsecure | 192.168.2.3

re)
] .)

Ubuntu ==

Apache2 Default Page

before continuing to operate your HTTP server.

site's administrator.

This is the default welcome page used to test the correct operation of the Apache2 server after
installation on Ubuntu systems. It is based on the equivalent page on Debian, from which the Ubuntu
Apache packaging is derived. If you can read this page, it means that the Apache HTTP server installed
at this site is working properly. You should replace this file (located at /var/wwwi/html/index.html)

If you are a normal user of this web site and don't know what this page is about, this probably means
that the site is currently unavailable due to maintenance. If the problem persists, please contact the
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SSL Configuration

In order to ensure that our website connection is secure, we need to enable SSL so our network
traffic is HTTPS. To enable SSL we can create a self-signed certificate.

Enable SSL Module

We will start by enabling an Apache module that provides support for SSL encryption.
Use the command: sudo a2enmod ssl
Restart Apache to activate the module: sudo systemctl restart apache2

1 how to config
ation, Yyou ne

5 ctl restart ap

Create a directory for the certificate: sudo mkdir /etc/ssl/private
NOTE: The directory is created with sudo so it can only be accessed by privileged users!

Generate a Private Key and Self-Signed Certificate:
sudo openssl req -x509 -nodes -days 365 -newkey rsa:2048 -keyout
letc/ssl/private/apache-selfsigned.key -out /etc/ssl/certs/apache-selfsigned.crt

After running the command, you will be prompted to fill out some information for your certificate:
NOTE: Make sure to put the proper FQDN of your website in the Common Name section!

e left blank.

Lo
Email

68



Configure Apache to use SSL
We need to create a VirtualHost that will facilitate HTTPS requests on port 443.

Create a new file with: sudo nano /etc/apache2/sites-available/slickbrickcentral.conf
NOTE: Make sure to match the ServerName with the Common Name you chose when setting
up the certificate! — slickbrickcentral.com

/etc/apache2/sites-availablesslickbrickcentral.conf
VirtualHost *:443

am
brickcentral.com

Let's now make a new DocumentRoot and put an HTML file for testing purposes!
Create your website’s root directory: sudo mkdir /var/www/slickbrickcentral.com

Create the landing page of the website:
sudo nano /var/wwwi/slickbrickcentral.com/index.html

GNU nano 7.2 svar/wwwsslickbrickcentral .coms index.html *

Next we need to enable the configuration file: sudo a2ensite slickbrickcentral.conf
Test the configuration file with the command: sudo apache2ctl configtest
Activate changes with the command: sudo systemctl reload apache2

1, Yyou need to run:

ver:/etc/ssl$ sudo apache2ctl configtes

etc/ss1% sudo
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Test HTTPS Connection
Go to your DMZ Client and visit your website with HTTPS!
In a browser enter https://slickbrickcentral.com

Upon navigating to your page you will see a warning about the self-signed certificate. You can
click “Advanced” towards the bottom of the warning graphic and then proceed to the website!

This server couldn't prove that it's slickbrickcentral.com; its security certificate is not trusted by your
computer's operating system. This may be caused by a misconfiguration or an attacker intercepting your

connection.

I Continue to slickbrickcentral.com (unsafe) I

Hide advanced m

You then should see your website landing page render with the simple message coded earlier.

Notice that the browser URL is using HTTPS!

3. im| @ slickbrickcentral.com X +

&« O © Notsecure | hitps//slickbrickcentral.com

Test Page
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Redirect HTTP to HTTPS

Currently, our configuration will only respond to HTTPS requests on port 443. It is good practice
to also respond on port 80, even if you want to force all traffic to be encrypted. Let’s set up
another VirtualHost to respond to these unencrypted requests and redirect them to HTTPS.

Open the same Apache configuration file:
sudo nano /etc/apache2/sites-available/slickbrickcentral.conf

GHU nano 7.2 /etc/apache2/sites-availablesslickbrickcentral.conf
VirtualHost =:443

om

‘dl.com

/WirtualHost

Next we need to refresh the configuration file: sudo a2ensite slickbrickcentral.conf
Test the configuration file with the command: sudo apache2ctl configtest
Activate changes with the command: sudo systemctl reload apache2

sudo aZensite slickbrickcentral.conft

sudo apache2ctl configtest

sudo systemct]l reload apache?

Test the redirect by trying to access your website with HTTP protocol!
You can do this by navigating in a browser to http://slickbrickcentral.com

L]

im] 3 Newtab X |-
C ( g slickbrickcentral.com
P2 Import favorites For quick access, place your favorites here on the favorites bar. Manage favorites now

The website should redirect the HTTP request to HTTPS!

(]

B @& slickbrickcentral.com x S
<« O | © HNotsecure | htps/slickbrickcentral.com |
Test Page

Disable the default configuration file: sudo a2dissite 000-default.conf
Reload Apache to apply changes: sudo systemctl reload apache2
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Static HTML Page

After verifying the server is running on our Ubuntu Server at 192.168.2.3, we need to create a
customized static HTML page to display!

| downloaded external images to a DMZ client and then used scp to transfer them to the
Apache Web Server:
scp <the/locallfile/path> user@[ip_address]:[the/server/destination/path]

r\Downloads\ png oneless

00:00

| then used ssh on the DMZ client to connect to the Apache server:
ssh onelessone@192.168.2.3

After logging in, | created an images directory within the website’s root directory:
sudo mkdir /var/www/slickbrickcentral.com/images

| then copied the uploaded files within the /static directory and transferred them to /images:
sudo cp /home/onelessone/static/* /[var/www/slickbrickcentral.com/images/
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After copying my website resources, | edited the base HTML page:
sudo nano /var/lwww/slickbrickcentral.com/index.html
EX onelessone@boontooboiserver: ~

GNU nano 7.2 JSvar/wi/slickbrickcentral.com/index.html

»Our Website is

After saving the file, render the new page contents in a browser: https://slickbrickcentral.com

&< O © Notsecure | hips//slickbrickcentral.com

Welcome to SlickBrickCentral

Here we sell aftermarket Legos!

({34

Our Website is currently a Work in Progress!
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pfSense Integration

| will have to port forward http and https traffic entering my pfSense address from the WAN to
the internal Apache Web Server.

To do this | can create a port forward rule to forward traffic on ports 80 (http) and 443 (https)
from 10.161.21.4 (pfSense WAN) to 192.168.2.3 (Apache Web Server).

First, go onto a LAN machine and navigate to the pfSense configuration portal:
http://192.168.1.1

In the top bar, navigate to Firewall > NAT > Port Forward

msense 3 s Firewall ~

COMMUNITY EDITION

Aliases
Firewall / NAT / Port Forward | war

Rules
Port Forward 1:1 Outbound NPt Schedules

Traffic Shaper

Vel e [


http://192.168.1.1

Add a new rule for HTTP traffic (port 80)

Firewall / NAT / Port Forward / Edit 12}
Disabled [ Disable this rule
No RDR (NOT) [ Disable redirection for traffic matching this rule

This option is rarely needed. Don't use this without thorough knowledge of the implications

Interface v
Choose which interface this rule applies to. In most cases "WAN" is specified
Address Family IPvd v
Select the Internet Protocol version this rule applies to
Protocol TCP w

Choose which protocol this rule should match. In most cases "TCP" is specified

ol

Destination () Invert match WAN address v ! v
Type Address/mask
Destination port range HTTP v HTTP v
From port Custom To port Custom

Specify the port or port range for the destination of the packet for this mapping. The ‘to’ field may be left empty if only mapping a single port

Redirect target IP Address or Alias P 19216823

Type Address

Enter the internal IP address of the server on which to map the ports. e.9.: 192.168.1.12 for IPv4
In case of IPvé addresses, in must be from the same "scope”
i.e. it is not possible to redirect from link-local addresses scope (fe80:*) to local scope (1

Redirect target port HTTP hd
Pornt Custom
Specify the port on the machine with the IP address entered above. In case of a port range, specify the beginning port of the range (the end port will be
calculated automatically)
This is usually identical to the "From port” above.
Description Port forward HTTP traffic to Apache Web Server
A description may be entered here for administrative reference (not parsed).
No XMLRPC Sync ) Do not automantically sync to other CARP members
This prevents the rule on Master from automatically syncing to other CARP members. This does NOT prevent the rule from being overwritten on Slave
NAT reflection Use system default v
Filter rule association Add associated filter rule v

The "pass" selection does not work properly with Multi-WAN. It will only work on an interface containing the default gateway.

_-___-_’
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Add a new rule for HTTPS traffic (port 443)

Firewall / NAT / Port Forward / Edit

Edit Redirect Entry

Disabled

No RDR (NOT)

Interface

Address Family

Protocol

Source

Destination

Destination port range

Redirect target IP

Redirect target port

Description

No XMLRPC Sync

NAT refiection

Filter rule association

Disable this rule

Disable redirection for traffic matching this rule

This option is rarely needed. Don't use this without thorough knowledge of the implications

WAN

w

Choose which interface this rule applies to. In most cases "WAN" is specified

IPva

Select the Internet Protocol version this rule applies to.

TCP

~

Choose which protocol this rule should match. In most cases "TCP" is specified

—

Invert match.

HTTPS v

From port

WAN address

Custom

e

Address/mask

HTTPS v

To port

Custom

Specify the port or port range for the destination of the packet for this mapping. The 'to’ field may be left empty if only mapping a single port.

Address or Alias

Type

v 192.168.2.3

Address

Port

HTTPS

Enter the internal IP address of the server on which to map the ports. e.g
In case of IPv6 addresses, in must be from the same "scope”

Specify the port on the machine with the |P address entered above.
calculated automatically)
This is usually identical to the "From port” above

Port forward HTTPS traffic 1o Apache Web Server

Use system default

Add associated filter rule

\

) Do not automatically sync to other CARP members

This prevents the rule on Master from automatically syncing to other CARP members. This does NOT prevent the rule from being

192.168.1.12 for IPv4

i.e. it is not possible 1o redirect from link-local addresses scope (feB0:*) to local scope (

W

Custom

n case of a port range, specify the beginning port of the range (the end port will be

A description may be emtered here for administrative reference (not parsed)

overwritten on Slave

W

The "pass” selection does not work properly with Multi-WAN. It will only work on an interface containing the default gateway

Final Port Forward Rules (make sure to Apply Changes)

Port Forward

11

Outbound

NPt

C Interface Protocol
0 + 33 wan TCP
O« 2 wan  TCP
0O v 28 wan TCP/UDP

Source Source Dest.
Address Ports Address
= = WAN
address
. * WAN
address
¥ . WAN
address

Dest. Ports  NAT IP

443 192168.23 443
(HTTPS)

80 (HTTP)  192.168.23 B8O (HTTP)
53(DNS) 19216823 53 (DNS)

) 8 (B3 ©

NAT Ports

(HTTPS)

Description

Port forward HTTPS traffic to Apache Web
Server

Port forward HTTP traffic to Apache Web
Server




Go to your WAN machine and verify you can access your Apache Web Server.

In the browser | will check by using my chosen domain name: slickbrickcentral.com

&« O © Notsecure | kttpsy/slickbrickcentral.com

Welcome to SlickBrickCentral

Here we sell aftermarket Legos!

({34

Our Website is currently a Work in Progress!

7



Project 7: Active Directory

Below contains steps outlining the configuration of an Active Directory Domain. The Windows
2022 Server (192.168.2.2) in the DMZ will be designated as the Domain Controller. Active
Directory Roaming Profiles will enable my employees to log into any LAN workstation and
maintain their user files and settings.

AD Information

AD Domain Controller: 192.168.2.2

AD Domain: ad.local

Usernames: AD\Administrator, bill, fernando
Employee Password: **Classified**

AD Setup

Active Directory is a Microsoft tool that helps manage users and computers in a network. It
organizes and controls access to resources like files and applications. | will be installing Active
Directory on my Windows 2022 Server within the DMZ under the IP Address 192.168.2.2!

Installing AD Role and Features

After logging into the Windows 2022 Server, open the Server Manager application.
Then in the upper right corner navigate to Manage > Add Roles and Features
- X

| ¥

Manage Tools View

Add Roles and Features

Remove Rales and Features

Add Servers

‘ Create Server Group

Server Manager Properties

Installation Type: Role-based or feature-based installation.

= Add Roles and Features Wizard — [m] x

DESTINATION SERVER

Select installation type WN-LRRTAAOTETS

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).

@ Role-basead or f based i

Configure a single server by adding roles, rele services, and features.

) Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.



Server Selection: Select your local server where you wish to install the AD DS role. This menu
shows our local server, WIN-UOOT4AO1ET9, its IP and OS.

Fﬁ. Add Roles and Features Wizard

Select destination server

Before You Begin

DESTIN

O X

ATIOM SERVER

WIN-UDOT4AC1ETS

Select a server or a virtual hard disk on which to install roles and features.

Installation Ty (® Select a server from the server pool
5 selection (_) Select a virtual hard disk
Server Rolas Server Pool
Features
Filter: |
MName IP Address Operating System

WIN-UOOT4AOTETS

Microsoft Windows Server 2022 Standard

1 Computer(s) found

| < Previous || Next > |

Install

This page shows servers that are running Windows Server 2012 or a newer release of Windows Server,
and that have been added by using the Add Servers command in Server Manager. Offline servers and
newly-added servers from which data collection is still incomplete are not shown,

Cancel

Server Roles: Select “Active Directory Domain Services”. Once you choose that option, a new
pop-up window will appear. This window shows the features required for AD DS that you will
need to include. Select “Include management tools” and click on “Add Features”.

NOTE: Disregard the DNS selection. That is not needed for Active Directory!

Fﬁ Add Roles and Features Wizard

Select server roles

Before You Begin

Installation Ty, Roles

[ Active Directory Cartifi i
I [] Active Directory Domain Services
| Active Lrectory Federafion Services

[] Active Directory Lightweight Directory Services
[] Active Directory Rights Management Services
[[] Device Health Attestation

[T DHCP Server

s

[] Fax Server

[m] File and Storage Services (1 of 12 installed)
[[] Host Guardian Service

[] Hyper-v

[ Network Policy and Access Services

[] Print and Dacument Services

[[] Remote Access

[] Remote Desktop Services

[] Volume Activation Services

[] Web Server {JIS)

[ Windows Deployment Services

[] Windows Server Update Services

Select one or more roles to install on the selected server.

= [m]

DESTINATION SERWER
WIN-UDOTAAOTETD

Description

Domain Name System (DNS) Server
provides name resolution for TCP/IP
networks. DNS Server is easier to
manage when it is installed on the
same server as Active Directory
Domain Services. If you select the
Active Directory Domain Services
role, you can install and configure
DNS Server and Active Directory
Domain Services to work together.

Install

x

[z, Add Roles and Features Wizard

Add features that are required for Active Directory
Domain Services?

You cannet install Active Directory Domain Services unless the
following role services or features are also installed.

[Tools] Group Palicy Management
4 Remaote Server Administration Tools
4 Role Administration Tools
4 AD DS and AD LDS Teols
Active Directory module for Windows PowerShell
4 AD DS Tools

[Tools] Active Directory Administrative Center
[Tools] AD DS Snap-Ins and Command-Line Tools

I Include management tools (if applicable) I /

Add Features Cancel
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Features: Select “Next”
AD DS: Select “Next”
Confirmation: Verify the Active Directory configuration and select “Install”

= Add Reles and Features Wizard 5 O x>
. . . . DESTINATIOM SERVER
Confirm installation selections WIN-UBOTEAGTETS
Before You Begin To install the following roles, role services, or features on selected server, click Install.
Installation Type [] Restart the destination server automatically if required
Server Salection Optional features (such as administration tools) might be displayed on this page because they have

been selected automatically. If you do not want to install these optional features, click Previous to clear

Server fRoles their check boxes,

Features

AD DS Active Directory Domain Services
Group Policy Management
Remote Server Administration Tools
Role Administration Tools
AD DS and AD LDS Teols
Active Directory module for Windows PowerShell
AD D5 Toals
Active Directory Administrative Center
AD DS Snap-Ins and Command-Line Tocls

Export configuration settings
Specify an alternate source path

< Previous Next > | Install | | Cancel |

NOTE: Keep the installation wizard OPEN until the installation is complete! Then select
“Promote this server to a domain controller”

f Add Roles and Features Wizard - O x
Installation progress P N-UOOTACIET?

View installation progress

o Feature installation
]

Configuration required. Installation succeeded on WIN-UDOT4AOQ1ET9.

Active Directory Domain Services
Additional steps are required to make this machine a domain controller.
IPrsmote this server to a domain controller I

Group Policy Management
Remote Server Administration Tools
Role Administration Tools
AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
AD DS Tools
Active Directory Administrative Center
AD DS Snap-Ins and Command-Line Tools

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings




A new setup window will appear. This contains three options for deployment: “Add a domain

controller to an existing domain”, “Add a new domain to an existing forest”, or “Add a new
forest”. Since we are starting from scratch, we are going to create a brand new forest.

AD Forest and Domain Controller

Deployment Configuration: Select “Add a new forest” and specify the Root domain name.

Root domain name: ad.local

fias Active Directory Domain Services Configuration Wizard = m] X
r o i TARGET SERVER
Deployment Configuration WIN-UOOT4AOIETS

Deployment Configuration

Select the deployment operation
Domain Cont: tions

() Add a domain controller to an existing domain
pto an existing forest

Specify the domain information for this operation

Root domain name: ad.local

More about deployment configurations

Domain Controller Options: Since this is the first AD domain controller, check the “DNS
server” and “Global Catalog” boxes. Give the Directory Services Restore Mode (DSRM) a
password. Then click on “Next”.

DSRM Password: **Classified**

[ Active Directory Domain Services Configuration Wizard = m} X
- ~ _ 2 TARGET SERVER
Domain Controller Options WIN-UOOTAAOIETS

Deployment Configuration

Select functional level of the new forest and root domain
Domain Controller Options

Forest functional level: Windows Server 2016

Domain functional level: Windows Server 2016 N

Specify domain controller capabilities

+/| Domain Name System (DNS) server
+ Global Catalog (GC)
Read only domain controller (RODC)

Type the Directory Services Restore Mode (DSRM) password
Password: ssssssssses

Confirm password: -

More about domain controller options
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DNS Options: SKIP, no need for DNS Delegation right now

Additional Options: Displays the NetBIOS domain name taken from the root domain. Ex: AD
Paths: You can specify the location of the AD DS database, log files, and SYSVOL folders.
Review Options: Check your configuration and go back if you want to make any changes
before installation. If everything looks good, click “Next”.

= Active Directory Domain Services Configuration Wizard = u] X
. , nQ TARGET SERVER
Review Op\ ons WIN-UOOT4AO1ET9

Review your selections:

Configure this server as the first Active Directory domain controller in a new forest.

The new domain name is "ad.local". This is also the name of the new forest.

The NetBIOS name of the domain: AD

Paths
Review Options Forest Functional Level: Windows Server 2016
Prerequisites Check Domain Functional Level: Windows Server 2016

Additional Options:
Global catalog: Yes

DNS Server: Yes

Create DNS Delegation: No

These settings can be exported to a Windows PowerShell script to automate

additional installations

More about installation options !

| < Previous | | Next » | nsta

Prerequisites Check: Shows you a checklist with warnings or critical alarms. If the check
passes, it will show a green light, and you’ll be able to install AD DS with the new domain
controller and forest. You can take care of these warnings later on.

Click “Install”. The server will then install and restart automatically.

= Active Directory Domain Services Configuration Wizard &= m] X
o . TARGET SERVER
Pr@eqmmtes Check WIN-UOOT4AOTET9

| @ All prerequisite checks passed successfully. Click ‘Install’ to begin installation. Show more x

Deployment Configuration . .
Prerequisites need to be validated before Active Directory Domain Services is installed on this
computer

Rerun prerequisites check

~

Additional Cptions
Paths @ View results
Review Options 1. Windows Server 2022 domain controllers have a default for the security setting named
- "Allow cryptography algorithms compatible with Windows NT 4.0" that prevents weaker
Prerequisites Check cryptography algorithms when establishing security channel sessions.

For more information about this setting, see Knowledge Base article 942564 (http://
go.microsoft.com/fwlink/?Linkld=104751).

1. A delegation for this DNS server cannot be created because the authoritative parent
zone cannot be found or it does not run Windows DNS server. If you are integrating
with an existing DNS infrastructure, you should manually create a delegation to this
DNS server in the parent zone to ensure reliable name resolution from outside the
domain “ad.local”, Otherwise, no action is required,

1, If you click Install, the server automatically reboots at the end of the promotion operation.

More about prerequisites
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After the server restarts, verify your configuration by opening the Server Manager application.

Then in the upper right corner navigate to Tools > Active Directory Users and Computers.
You should see the domain name you picked! My domain was ad.local.

| I' Manage  Tools View

Active Directory Administrative Center
Active Directory Domains and Trusts
Active Directory Module for Windows PowerShell

Active Directory Sites and Services

I Active Directory Users and Computers I
ADSI Edit
Component Services
. Computer Management
Defragment and Optimize Drives
Disk Cleanup
DNS
i | t ute [ X adlocal Properties
File Action View Help General  Managed By
* == =] - - — -
&= 71E0EBeE HE A aETER ﬂ adlocal
: Active Directory Users and Com|| Name Type Description
: i - Domain name (pre-Windows 2000):
= 5;"'“' ?“”“ | 11 Builtin builtinDomain R
v oFE - gc?h, [ Computers Container Default container for up...
uiitin [ . - - - Descriptic
JJ Computers =! Domain Con... Organizational... Default container for do... [ -
= Dom:m Controllers [ ForeignSecu... Container Default container for sec... Do ot e
d o . . i :
“] ForeignSecurityPrincipal{| — Managed Se... Container Default container for ma... Windows Server 2016
| Managed Service Accour|| — Users Container Default container for up...
1 Users Forest functional leve!
= Windows Server 2016




AD DNS Server Zones

You already installed AD DS, the DNS role, and created a new Forest and Domain Controller
(DC). Now you only need to configure the DNS zones.

A DNS zone is formed by the mappings of IPs and hostnames used to resolve DNS queries.

The most common zone type in Active Directory is the Active Directory-integrated DNS zone.

Forward Lookup Zone
In the upper right corner navigate to Tools > DNS

Active Directory Administrative Center

Active Directory Domains and Trusts
Active Directory Module for Windows PowerShell
Active Directory Sites and Services
Active Directory Users and Computers
ADSI Edit
Component Services

I Computer Management
Defragment and Optimize Drives
Disk Cleanup
DNS
Event Viewer

Group Policy Management

Expand the “Forward Lookup Zones” directory and you will see the root domain name chosen
earlier (ad.local) and the _msdcs zone which is created by default.
£, DNS Manager - O X

File Action View Help
e 2@z Hm i8S

£ DNs Name - Type Status DNSSEC Status

v 3 WIN-UDOTAAOTET.ad local :]_msdcs.adJDCﬂl Active Directory-Integrated Pr... Running Not Signed
v | Forward Lookup Zones -]ad local

| _msdcs.ad.local

= ad.docal

Reverse Loolcum
| Trust Points

| Conditional Forwarders

Active Directory-Integrated Pr... Running Not Signed
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Reverse Lookup Zone

The Forward Lookup Zone is already pre-populated but the Reverse Lookup Zone is not. Create

a new zone by right clicking the “Reverse Lookup Zones” directory and selecting “New Zone”.

e —— || stores intormati
| Reverse Looku)

| Trust Points New Zone... ol
| Conditional Fo M o
Refresh
Help

Zone Type: Check “Primary Zone” and “Store the zone in Active Directory”
New Zone Wizard

X
Zone Type
The DNS server supports various types of zones and storage. p
|~

Select the type of zone you want to create:

(@) Primary zone
Creates a copy of a zone that can be updated directly on this server,

() Secondary zone
Creates a copy of a zone that exists on another server. This option helps balance
the processing load of primary servers and provides fault tolerance.

(O Stub zone
Creates a copy of a zone containing only Name Server (NS), Start of Authority
(SOA), and possibly glue Host (A) records, A server containing a stub zone is not
authoritative for that zone.

[#] Store the zone in Active Directory (available only if DNS server is a writeable domain
controller)

<ok Concel

AD Zone Replication Scope: Check “To all DNS servers running on domain controllers in this

domain: <your domain>"

New Zone Wizard X
Active Directory Zone Replication Scope
‘You can select how you want DNS data replicated throughout your network. .
r

Select how you want zone data replicated:
(O To all DNS servers running on domain controllers in this forest: ad.local

(®) To all DNS servers running on domain controllers in this domain: ad.local

(O To all domain controllers in this domain (for Windows 2000 compatibility): ad.local

To all domain controllers specified in the scope of this directory partition:

= =

Reverse Lookup Zone Name: Select “IPv4 reverse lookup zone” and click “Next”
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Reverse Lookup Zone Name: Specify the Network ID of the reverse zone to help identify the
reverse lookup zone. The first three octets of your Windows Server’s IP are used for the
Network ID.

Windows 2022 Server: 192.168.2.2

New Zone Wizard X
Reverse Lookup Zone Name
A reverse lookup zone translates IP addresses into DNS names. -
>
, type the network ID or the name of the zone.
(®) Network ID:
|1 92 168 2 .

T i the IP addresses that belongs to this zone. Enter the
network ID in its normal (not reversed) order,

If you use a zero in the network ID, it will appear in the zone name. For example,

network ID 10 would create zone 10.in-addr.arpa, and network ID 10.0 would create
zone 0. 10.in-addr.arpa.

(O)Reverse lookup zone name:

2,168,192 in-addr.arpa

< Back Next > Cancel

Then, click “Next > “Next” > “Finish”.

Check your new Reverse Lookup Zone. Inside, you should see two DNS resource records, SOA
and NS.

2 DNS Name Type Data Timestam
v 3 WIP::—UUOTdAOTiTQ‘aZd.IocaI E-I(same as parent folder) Start of Authority (SOA) [1], win-u00tdaol1et9.ad.lo... static
v [ Forward Lookup Zones E_-I(same as parent folder) Name Server (NS) win-ul0tdaolet9.ad.local. static

- | _msdcs.ad.local

ad.local
v [ Reverse Lookup Zones
- 2168.192.in-addr.arp

T Trust Points

| Conditional Forwarders
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Update A Records

Open your domain name directory within the Forward Lookup Zone and then double-click the

Host A record.

& D_NS Name Type Data Timestam
v 5 WIN-UDOT4AO1ET9.ad local '] medcs
v Fs_:n.vard Lookup Zones 'j'mg
.| _msdcs.ad.local j-tcp
=/ adlocal -
v [ ] Reverse Lookup Zones Suop i
] 2.168.192in-addr.arp gf":z;o;z“““
: . orestDnsZones
" Ir::;i:;:: Forwarders E-I(same as parent folder) Start of Authority (SOA) [21], win-uD0tdaoletd.adl... static
) Ej(same as parent folder) MName Server (NS) win-ul0tdaolet9.ad.local. static
|| (same as parent folder) Host (A) 192.168.2.2 4/9/2025 :
Ime—uDOMaMetg Host (A) 192.168.2.2 static I

A popup window will open and make sure to select “Update associated pointer (PTR) record”.
Then click on “Apply” and “Ok” to save changes.

win-u00tdao1etd Properties ? X

Host () Securty

Host (uses parent domain if left blank):
|W|nuDQAaa1el9 |

Fully qualfied domain name (FQDN)
[wins00430 1et3 ad local |

IP address:
[19216822 |

Update associated pointer (PTR) record

=

Verify Reverse Lookup Zone
If you don’t see the PTR record in the reverse lookup zone, you'll need to refresh. Click the

refresh button on the top bar and the new PTR record should appear.
e 2R XEG= Bm i@
/

& [ZNS MName Type Data Timestam
v B \'\.fIN—UDOTdAOTETEad.IocaI E-I(same as parent folder) Start of Authority (SOA) [2], win-uO0tdaoletd.ad.lo... static
v Forward Lockup Zones
o dcs.ad.local
7 -msccs.adloca 19216822 Pointer (PTR) win-ud0tdaoletd.adocal.  static
iz adlocal
v || Reverse Lookup Zones

=) 2.168.192.in-addr.arp
| Trust Points
| Conditional Forwarders




AD Domain Controller Verification

Verify your server is the AD Controller by navigating in the top right corner of Server Manager to
Tools > Active Directory Users and Computers.

Once the pop-up opens, expand your domain name and then look into the “Domain Controllers”
section. Your current machine should be listed!

] Active Directory Users and Computers - O X

File Action View Help

oo 25 0Bz HETaEaTYa%

: Active Directory Users and Com | Name Type DC Type Site Description
al Saved Queries M&/WIN-UOOT4.. Computer GC Default-First-Si...
v 4 ad.local
| Builtin
| Computers

= | Domain Controllers

_| ForeignSecurityPrincipal
| Managed Service Accour
| Users
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Creating AD Users

In order to create users for your Active Directory open the Server Manager application.
Next, in the upper right hand corner navigate to Tools > Active Directory Users and
Computers.

Manage Tools View Help

Active Directory Administrative Center
Active Directory Domains and Trusts
Active Directory Medule for Windows PowerShell

Active Directory Sites and Services

I Active Directory Users and Computers I
ADSI Edit

Component Services

I Computer Management
Defragment and Optimize Drives
Disk Cleanup

DNS

Event Viewer

A pop-up window will appear. Right-click on your domain and then navigate to New >
Organizational Unit.
e 2@ OB Hm 3emTHA%S

W&D\rattnw Users and Com|| Name Type Descrition
- pved Queries I Builtin builtinDomain
v i addocal Delegate Control . atainer Default container for up...

| i F\::iﬂ € monieh anizational.. Default container for do...
= ainer Default container for sec...
= e luoans Mainer Default container for ma...
= Change Domain Controller... itainer Default container for up...
= u Raise domain functional level...

\ Operations Masters...

New > Cemputer
All Tasks > Centact
View » &
InetOrgPerson
Refresh msDS-ShadowPrincipalContainer
O mslmaging-PSPs
Properties MSMQ Queue Alias
Printer
User
< >

Shared Folder —
Creates a new item in this container.

Name your Organizational Unit. | will be naming mine Employees since it will contain worker
data.

Mew Object - Organizational Unit X
- Createin:  adlocal/
Name:
|Emp\oyees

Protect container from accidental deletion

Cancel Help
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Right-click the newly created OU and then navigate to New > User.

\A Users I

| Emplc
= S Delegate Control...

Move...
\ Find...

New > Computer

All Tasks > Contact

View > Group
InetOrgPerson

= msDS-ShadowPrincipalContainer

Delete mslmaging-PSPs
Rename MSMQ Queue Alias
. Refrash Organizational Unit
- Export List... N
Creates a new iter e
T Properties User i
. Shared Folder

I will be creating two users for my workforce: Bill and Fernando
Note: Make sure to check the box “Password never expires” so you will not have to change it on
the first logon for your users.

Usernames: bill or fernando
Password: **Classified* (same for both users)

New Object - User bt New Object - User X
3) Create in:  ad local/Employees g) Createin:  adlocal/Employees
First name: |Bi|| | Initials: | | First name: Femando Initials: I:I
Last name: |Bob | Last name: Minecraft |
Full name: |Bi|| Bob | Full name: [Femando Minecraft |
User logon name: User logon name:
[l || @adlocal v [femandel || @sdlocal v
User logon name (pre-Windows 2000): User logon name (pre-Windows 2000):
|AD\ | |bi" | AD\ | |lemamd0 |
< Back MNet > Cancel SRk Next > Cancel
New Object - User X New Object - User x
&) Createin:  adlocal/Employees 3) Createin:  ad local/Employees
Password: |............. | Password: |o..o.o..o.o....o-
Confirm password: |unnnnon| | Confirm password: |-nn-nn-nnu
[] User must change password at next logon [[] User must change password at next logon

[ User cannet change password [[] User cannot change password

Password never expires [A] Password never expires

[ Account is disabled [ Account is disabled

< Back Next > Cancel < Back Cancel
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After creating both users you should see them under the Employees OU!
Name Type Description

&, Bill Bob User
E,,Femando Mi... User

To validate they are in your Active Directory Domain, right-click each user and then select
“Properties”. Then navigate to “Member Of” and verify your domain is listed.

Bill Bob Properties ? X
Remote control Remote Deskiop Services Profile COM=+
General Address Account Profile Telephones Organization
Member Of Dialin Environment Sessions
Member of:
Name Active Directory Domain Services Folder
Domain Users ad local/Users
Add... Remove
Primary group: Domain Users

Success! Next, we'll join two workstations to our AD domain, allowing us to sign in with the
users we've just created.
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Joining Clients to AD

In order to add a windows workstation to an Active Directory, it must be able to connect to a
network with an AD Domain Controller. Luckily, our LAN workstations can communicate with
DMZ hosts like the AD Domain Controller!

Client DNS Setup

In the Windows 2022 Server, open the Server Manager application, navigate to the top right
corner and select Tools > DNS.

A DNS Manager pop-up will appear. Within the window, right-click the DNS server name and
select “Properties”. Navigate to the Forwarders section, input your preferred DNS server

forwarder, and click “Apply”. | will be choosing to forward to my pfSense server at 192.168.2.1.

WIN-UOOT4AO1ET9.ad.local Properties ? X
Debug Logging Event Logging Monitoring Security
Interfaces Forwarders Advanced Root Hints

Forwarders are DNS servers that this server can use to resolve DNS
queries for records that this server cannot resolve

IP Address Server FQDN
192.168.2.1 <Unable to resolve> I
Use root hints if no forwarders are available Edit...

Note: If conditional forwarders are defined for a given domain, they will be
used instead of serverdevel forwarders. To create or view conditional
forwarders, navigate to the Conditional Forwarders node in the scope tree

Cancel Apply Help

This will ensure all unknown queries given to the AD Domain Controller will be forwarded
elsewhere to resolve.
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Next, open the pfSense Admin portal in a browser at http://192.168.1.1 and login. Once in the
portal navigate in the top bar to Services > DHCP Server. Make sure you are in the “LAN” tab
and then scroll until you see DNS servers and assign the AD Domain Controller as primary DNS
(192.168.2.2) and then pfSense as secondary DNS (192.168.1.1).

Server Options

WINS Servers

DNS Servers 192.168.2.2

192.168.1

Doing this will allow all LAN workstations to be automatically issued the AD Domain Controller
for DNS: ad.local.

Renaming Client Device

On your Windows workstation open the Settings app. Then navigate to System > About.
Click “Rename this PC” in the upper right hand corner and create a unique name to the two
client computers.

Workstation Names: WS-1 and WS-2

System > About

D,E.S‘K,_T,OPUAHLEPK Rename this PC

® Device specifications Copy ~

Device name DESKTOP-UAHLEPK

Processor Intel(R) Xeon(R) CPU E5-2695 v3 @ 2.30GHz 230 GHz (2 processors
Installed RAM 00
Device ID 0160C75F-1C8F-4294-BBD2-BECC37E776IE
Product ID 003

System type 64-

Pen and touch No pen or touch input is available for this display

Related links  Domain or workgroup ~ System protection ~ Advanced system settings

After renaming each workstation, restart the device!
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Connecting Client to AD

Open the Settings app again and navigate to System > About menu, and then select
“Advanced system settings”.

System > About

Ws-1 - Rename this PC
VMware7,1
@ Device specifications Copy ~
Device name WS-1
Processor Intel(R) Xeon(R) CPU E5-2695 v3 @ 2.30GHz 2.30 GHz (2 processors)
Installed RAM 8.00 GB
Device ID 0160C75F-1C8F-4294-BBD2-BECC37E7761E
Product ID 00331-10000-00001-AA031
System type 64-bit operating system, x64-based processor

Pen and touch  No pen or touch input is available for this display

Related links  Domain or workgroup ~ System protection | Advanced system settings

A pop-up window will open. Navigate to “Computer Name” on the top bar and click the “Change”
button.

System Properties X

Hardware Advanced System Protection Remote

Windows uses the following information to identify your computer

on the network.

Computer description: |
For example: "Kitchen Computer” or "Mary's
Computer”.

Full computer name: WS-1

Workgroup: WORKGROUP

To use a wizand to join a domain or workgroup ., click

Network 1D Netwark 1D..

To rename this computer or change its domain or
workgroup. click Change. ———

You then need to enter your domain name: ad.local and then click “Ok”.

Computer Name/Domain Changes X
YYou can change the name and the membership of this
computer. Changes might affect access to network resources.

Computer name:
WS-1

Full computer name:
W5-1

Member of
© Domain:
ad locall

O Workgroup:
WORKGROUP
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Enter the credentials of one of the AD users configured earlier to join the domain!

Username: bill or fernando
Password: **Classified**

== ‘Windows Security x

Computer Name/Domain Changes

Enter the name and password of an account with permission to
join the domain.

User name

bill

Password

oouolcn'cuu'co'oul

“ Cancel

If login is a success, you will see the following message.

B " Computer Name/Domain Changes X

b B
[ o Welcome to the ad.local domain.
5
a
oK

%

Restart to apply changes!

Microsoft Windows X

You must restart your computer to apply these
changes

Before restarting, save any open files and close all programs.

[ Restart Now | Restart Later

After restart, select “Other user” login and you should see your AD domain listed. You then can

sign in with one of the AD user accounts.

Other user

Dser name
Password

Sign in to: AD

How do | sign in to another domain?

Other user
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Delete Local Accounts

There is no need for the local account on our Windows workstation since we have Active
Directory connected. Let’s delete it!

Login to your workstation with the Administrator Active Directory user.
Username: AD\Administrator

Other user

AD\Administrator

Sign in to: AD

How do | sign in to another domain’

Right-click the Windows button and select “Computer Management”.

i Disk Management —

I Computer Management I

Windows PowerShell
Windows PowerShell (Admin)
Task Manager

Settings

File Explorer

Search

A

Run

Shut down or sign out

Desktop

== Q Search “‘

Navigate into Local Users and Groups > Users and right-click the local user you want to delete.

A Computer Management

File Action View Help

oo nEXE | HE
2 ;omPMerManagement (Local| Name Full Name Description
v [fi System Tools #., Administrator Built-in account for administering...
> @ sk Schehler g8l | [
-
> Event V Set Password...
@. vent viewer P, DefaultAcco... 1ser account managed by the s...
» @ Shared Folders L.
#, Guest All Tasks > ilt-in account for guest access t...

W % Local Users and Groups

3 4 WDAGUtility.. 1ser account managed and use...

| Groups

_ R
> (N Performance ename
A Device Manager Properties
v &5 Storage
& Disk Management Help

> Ty Services and Applications
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After deletion, there should be no local users remaining!

Name Full Name
&Administratnr

#s, DefaultAcco...

!Q,Guest

#. WDAGUtility...

Description

Built-in account for administering...
A user account managed by the s...
Built-in account for guest access t...
A user account managed and use...
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Roaming Profiles

Active Directory Roaming Profiles are a Windows Server feature that allow users to access
their personal desktop settings and files from any computer within the domain.

Before configuring a Roaming Profile, we need to create a Share. Open the Server Manager
application and navigate to File and Storage Services > Shares.

= Server Manager

@ ~  Server Ma

— Servers

i Volumes

[ Disks

il Storage Pools

2

iSCsI
Work Folders

Create a new Share.

=~ SHARES

All shares | 2 total

New Share..,
Fi L v (A

- Refresh b:

I I
Share Local Path Protocol Availability Type
17.5% Use
4 WIN-UOOT4AOTETS (2) =

NETLOGON C:\Windows\SYSVOL\sysvohad.loc... SMB Not Clustered
SYSVOL CAWindows\SYSVOL\sysvol SMB Not Clustered

Select Profile: SMB Share - Quick

Share Location: C:\Roaming_Profiles$

T New Share Wizard = o X

Select the server and path for this share

Select Profile Server
Server Name Status Cluster Role Owner Node
WIN-UOOT4AQTET9 Online Not Clustered

Share Name

Share location:

() Select by volume:
Volume Free Space Capacity File System
G 73.7GB  893GB NTFS

The location of the file share will be a new folder in the \Shares directory on the selected
volume.

@ Type a custom path:
CARoaming_Profilesq Browse...




Share Name: Click “Next”

Other Settings: Make sure to check “Enable access-based enumeration”.

f& New Share Wizard - [m] X

Configure share settings

Select Profile I Enable access-based enumeration I
Share Location Access-based enumeration displays only the files and folders that a user has permissions to
- access. If a user does not have Read (or ivals issi for a folder, Wind: hides the
Share Name folder from the user's view.

Allow caching of share
Permissions Caching makes the contents of the share available to offline users. If the BranchCache for

Network Files role service is installed, you can enable BranchCache on the share.
Enable BranchCache on the file share
BranchCache enables computers in a branch office to cache files downloaded from this
share, and then allows the files to be securely available to other computers in the branch.
[] Encrypt data access
When enabled, remote file access to this share will be encrypted. This secures the data against

unautherized access while the data is transferred to and from the share. If this box is checked
and grayed out, an administrator has turned on encryption for the entire server.

Create
. . . . “ . . . »
Permissions: Click “Customize Permissions”.
fs New Share Wizard - ] X
Specify permissions to control access
Select Profile Permissions to access the files on a share are set using a c ination of folder permissions, share
Share Location permissions, and, optionally, 2 central access policy.
Share Name Share permissions: Everyone Full Control
O i Folder permissions:
Type Principal Access Applies To
Confirmation Allow CREATOR OWNER Full Control Subfolders and files only
Allow Special This folder and subfolders
Allow Read & execu... This folder, subfolders, and files
Allow Full Control This folder, subfolders, and files
Allow Full Control This folder, subfolders, and files
“ » H H
Add” a new permission.
Advanced Security Settings for Roaming_Profiles$ (m] X
Name: C:\Roaming_ProﬂlesS
Owner: Administrators (AD\Administrators) Change
Permissions Share Auditing Effective Access

For additional information, double-click a permission entry. To modify a permission entry, select the entry and click Edit (if available).

Permission entries:

Type Principal Access Inherited from Applies to
82 Allow SYSTEM Full control C:\ This folder, subfelders and files
“ Allow  Administrators (AD\Administr... Full control C\ This folder, subfolders and files
82 Allow  Users (AD\Users) Read & execute (=1} This folder, subfolders and files
88 Allow  Users (AD\Users) Special C\ This folder and subfolders
ﬂ Allow  CREATOR OWNER Full control (1} Subfolders and files only

| Add | Remove View

Disable inheritance

[ Replace all child object permission entries with inheritable permission entries from this object
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Click “Select a principal” and then enter “Domain Users” in the pop-up window. Select “Check
Names” to validate your selection and then choose “Ok” to lock in configurations.

O

Principal:  Select

Type: Allow

Select this object type

Select User, Computer, Service Account, or Group

This folder, subfolders and files

Applies to:

‘ User, Group. or Builtin security principal

From this location:

‘adiucd

Basic permissions:

Full control

Modify

Read & execute

List folder contents

Read Advanced...

to select (examples):
Domain Users| I

| | Obpect Types...

Locations...

Check Names

Cancel

Write

Special permissions

Only apply these permissions to objects and/or containers within this container

Clear all

Ensure the following permissions are set so AD users have close to full access to their own file

systems. Click “Ok” when done!

Permission Entry for Roaming_Profiles$

Principal:  Domain Users (AD\Domain Users) Select a principal
Type: Allow v
Applies to: | This folder, subfolders and files ~

Basic permissions:

[ Full control

[ Modify

Read & execute
List folder contents
Read

Write

Special permissions

[]0nly apply these permissions to objects and/or containers within this container

Add a condition to limit access. The principal will be granted the specified permissions only if conditions are met.

Add a condition

In the original popup-window select “Apply” and then “Ok”.

Advanced Security Settings for Roaming_Profiles$

=] X

Name: C:\Roaming_ProfilesS
Owner: Administrators (AD\Administraters) Change
Permissions Share Auditing Effective Access
For ion, double-click 2 p entry. To modify a permission entry, select the entry and click Edit (if available).
Permission entries:
Type  Principal Access Inherited from Applies to
S& Allow  Domain Users (AD\Domain U...  Read, write & execute None This folder, subfolders and files
82 Allow  SYSTEM Full control A\ This folder, subfolders and files
B2 Allow  Administrators (AD\Administr... Full control c\ This folder, subfolders and files
B2 Allow  Users (AD\Users) Read & execute c\ This folder, subfolders and files
8% Allow  Users (AD\Users) Special c\ This folder and subfolders
8% Allow  CREATOR OWNER Full control A\ Subfolders and files only
Add Remove Edit

Disable inheritance

[[JReplace all child object permission entries with inheritable permission entries from this object

Show advanced permissions

Clear all

Cancel
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Confirmation: Click “Create” when ready.

f&s New Share Wizard - [m] X

Confirm selections

Select Profile Confirm that the following are the correct settings, and then click Create.

Share Location
SHARE LOCATION

Share Name

Server: WIN-UOOT4AO1ET9
Cluster role: Not Clustered
rm 3 Local path: CA\Roaming_Profiles§

SHARE PROPERTIES
Share name: Roaming_Profiles$
Protocol SMe
Access-based enumeration Enabled
Caching Enabled
BranchCache: Disabled
Encrypt data: Disabled

Next > ‘ Create H Cancel |

Navigate to Tools > Active Directory Users and Computers > Employees. Then, right click
on a user and select “Properties”. Within the popup window, open the “Profile” section and
specify the following Profile path: \\server_name\profile_folder_name\%username%.

| used: \WIN-U00T4A0O1ET9\Roaming_Profiles$\%username%

: Active Directory Users and Computers Bill Bob Properties T X
Fil Acti Vi Hel
e on e P Member Of Dialin Environment Sessions
@$| valllzal ‘{ B XD.&£> TTI.-1 ‘J aETER Remote control Remote Desktop Services Profile COM+
= — Profile izati
] Active Directory Users and Com|| Name Type Description General  Address  Account Telephones  Organization
Saved Queries & Bill Bol User profile
v &4 adlocal & Fernan Copy... Profie path: | FUDOT4AOTETS\Roaming_Profies$\%usemame ]
- Builtin Add to a group...
- Cnmp,me's Disable Account Logon scrl:
2| Domain Controllers
5 Employees Reset Password... Home folder
| ForeignS Pri I Move...
-J orelgn E(Uﬂty' ﬂn(\pa @LDCE‘ pdh
_| Managed Service Accour Open Home Page
| Users Send Mail (O Connect:
All Tasks >
Cut
Delete
Rename
Properties
Help
< >
Resets the password for the current selection. Cance Aoply Hep

Click “Apply” and “Ok” when done!
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Project 8: VPN Server

Below contains steps outlining the configuration of a WireGuard service on my pfSense
firewall (10.161.21.4). The VPN server will be used to allow approved external clients to
connect to an internal VPN subnet enabling them to access select internal services. In a real
world scenario, this is very helpful for remote work since employees can use a VPN to securely
connect to the organization’s network from anywhere.

VPN Information

pfSense Firewall: 10.161.21.4

WireGuard Port: 51820 (default)

Internal VPN Subnet: 192.168.3.0/24
WAN Client IP: 10.161.21.20

Internal Client IP Assignment: 192.168.3.2

pfSense Configuration

I will be using WireGuard to host a vpn service on my pfSense firewall.

Install WireGuard

WireGuard is a modern, lightweight VPN protocol that operates in the Linux kernel for high
performance and minimal overhead, making it ideal for both mobile and server environments.
As a VPN server, WireGuard can be deployed to allow remote clients to securely access private
networks, route internet traffic through encrypted tunnels, or connect multiple networks across
locations.

| will create a 3rd subnet managed by pfSense to facilitate my VPN server.
LAN: 192.168.1.0/24
DMZ: 192.168.2.0/24
VPN: 192.168.3.0/24
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Login to the pfSense admin dashboard within a browser at http://192.168.1.1

Navigate to System > Package Manager > Available Packages

flisense  system -

COMMUNITY EDITION

Advanced
Status/ [ cenificates

General Setup

System Info High Availability
Name Package Manager

User Register 2
System Routing \in
Setup Wizard I3
Blos Update n
User Manager S
Version Logout (admin) &

built on Wed Dec 6 20:1

CemaDOM 14 A ALINRCRE

Search for “WireGuard”

Search term WireGuard Both v I ‘

Enter a search string or *nix '-3q..\a' expression to search :a:l:aqc names and dE‘DC'IDT\O’T‘Z.

Once the WireGuard package is located, click Install.

WireGuard 0.2.1 WireGuard(R) is an extremely simple yet fast and modern VPN that utilizes state-of-the-art cryptography. It aims to be faster, simpler, leaner, and o Instal
more useful than IPSec, while avoiding the massive headache. It intends to be considerably more performant than OpenVPN. WireGuard is
designed as a general purpose VPN for running on embedded interfaces and super computers alike, fit for many different circumstances. Initially
released for the Linux kernel, it is now cross-platform and widely deployable. It is currently under heavy development, but already it might be
regarded as the most secure, easiest to use, and simplest VPN solution in the industry.

Confirm the installation.

pfSense-pkg-WireGuard installation successfully completed.
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Create WireGuard Tunnel

Navigate to VPN > WireGuard using the top bar and click Add Tunnel.
Flisense

COMMUNITY EDITION

VPN / WireGuard / Tunnels =@
Tunnels Peers Settings Status
WireGuard Tunnels
Name Description Public Key Address / Assignment Listen Port Peers Actions
< Add Tunnel

WireGuard Configuration
e Port: 51820
e Public Key: YSZ33x10OWiYAYQHVc4geSH9jx5zhngwWLarokCGA4XI=

Tunnel Configuration (tun_wgQ0)

Enable Enable Tunnel

Note: Tunnel must be enabled in order to be assigned to a pfSense interface

Description

Description for administrative reference (not parsed)

Listen Port

Port used by this tunnel to communicate with peers

Interface Keys

YSZ33x10WiYAYQHVec4geSHYjx5zhngwWlLarokCGA4X m

Private key for this tunnel. (Required Public key for this tunnel. (Copy New Keys
Assignment "-‘—.Ir\twfa:'é.ﬁ-silgnm;‘ﬂ‘;
Firewall Rules ) WireGuard Interface Group
Hint These interface addresses are only applicable for unassigned WireGuard tunnel interfaces.
Interface Addresses 192.168.3.0 /124 il
IPv4 or IPv6 address assigned to the tunnel interface D[-:;:rlp’,\c-“ for administrative reference (not parsed

Add Address o Add Address
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Navigate to the Settings tab and “Enable WireGuard”.

Tunnels Peers Settings Status

General Settings

Enable

Enable WireGuard

Note: WireGuard cannot be disabled when one or more tunnels is assigned to a pfSense interface.

Keep Configuration

Endpoint Hostname
Resolve Interval

Interface Group
Membership

Result:

Enable

Note: With 'Keep Configurations' enabled (default), all tunnel configurations and package settings will persist on install/de-install.

300 [7) Track System Resolve Interval
Interval (in seconds) for re-resolving endpoint host/domain names Tracks the system ‘Aliases Hostnames Resolve Interval' setting
Note: The default is 300 seconds (0 to disable). Note: See System > Advanced > Firewall & NAT

All Tunnels b

Configures which WireGuard tunnels are members of the WireGuard interface group
Note: Group firewall rules are evaluated before interface firewall rules. Default is 'All Tunnels

VPN / WireGuard / Tunnels CO®O=u@

Tunnels Peers Settings Status

Name Description

> tun_wg0

Public Key Address / Assignment Listen Port Peers  Actions
YSZ33x10WIiYAYQHVc4geSHOjx5zhngwW... 192.168.3.0/24 51820 0 atsS E0m

Add Tunnel
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Interface Assignment

I now need to configure the network interface for WireGuard.

Navigate to Interfaces > Assignments using the top bar
msel‘lse System ~ Interfaces ~

COMMUNITY EDITION
Assignments

Status / Dashboard

WAN
System Information LAN -
DMZ

Name pfSense sli¢

Select Add to enable the VPN interface.

Interface Network port

WAN vmx0 (00:50:56:82:4a:58) v

LAN vmx1 (00:50:56:82:¢8:d7) v m
DMZ vmx2 (00:50:56:82:95:7a) v
Available network ports: tun_wg0 (tun_wg0) v

Click on the new interface name “OPT2” to open the configuration menu.

oPT2 tun_wg0 (tun_wgQ) v m Delete

VPN Interface Configuration

Enable the Interface

Static IPv4

IP Range: 192.168.3.1/24

Keep “Block private networks” and “Block bogon networks” unchecked
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General Configuration

| Enable Enable interface I

Description VPN

Enter a description (name) for the interface here.

IPv4 Configuration Type v
IPv6 Configuration Type None v
MAC Address XX XK XXX XX
This field can be used to modify ("spoof”) the MAC address of this interface
Enter a MAC address in the following format: sxx:ocxcxxocxx or leave blank
MTU
If this field is blank, the adapter's default MTU will be used. This is typically 1500 bytes but can vary in some circumstances.
MSs

If a value is entered in this field, then MSS clamping for TCP connections to the value entered above minus 40 for IPv4 (TCP/IPv4 header size)and
minus 60 for IPv6 (TCP/IPv6 header size) will be in effect

Static IPv4 Configuration

| IPv4 Address 192.168.3.1 |

IPv4 Upstream gateway None v < Add a new gateway

If this interface is an Internet connection, select an existing Gateway from the list or add a new one using the "Add" button
On local area network interfaces the upstream gateway should be "none”

Selecting an upstream gateway causes the firewall to treat this interface as a WAN type interface

Gateways can be managed by clicking here

Reserved Networks

Block private networks (]
and loopback addresses

Blocks traffif from IP addresses that are reserved for private networks per RFC 1918 (10/8, 172.16/12, 192.168/16) and unique local addresses per
RFC 4193 (ff00:/7) as well as loopback addresses (127/8). This option should generally be turned on, unless this network interface resides in such a
private addrpss space, too

Block bogon networks C

Blocleioro

from reserved IP addresses (but not RFC 1918) or not yet assigned by IANA. Bogons are prefixes that should never appear in the Internet
routing table, and so should not appear as the source address in any packets received

This option should only be used on external interfaces (WANSs), it is not necessary on local interfaces and it can potentially block required local traffic.
Note: The update frequency can be changed under System > Advanced, Firewall & NAT settings

Click Save at the bottom when you are done and then Apply Changes.

Result:
Interfaces / Interface Assignments L @
Interface Assignments Interface Groups Wireless VLANs QinQs PPPs GREs GlIFs Bridges LAGGs

Interface Network port

WAN vmx0 (00:50:56:82:4a:58) h

LAN vmx1 (00:50:56:82:8:d7) v m
DMZ vmx2 (00:50:56:82:95:7a) v

VPN tun_wg0 (tun_wg0) v
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Firewall Rules

VPN Rules
I want the VPN subnet to not allow any communication to the LAN and allow all communication

to the DMZ.

Navigate to Firewall > Rules using the top bar.

msense System Firewall ~

COMMUNITY EDITION

Aliases

Interfaces / Interface Assignme nar

Interface Assignments Interface Groups Schedules Q

Traffic Shaper

Interface Network port Virtual IPs

Within the VPN tab, create new firewall rules.

Rule 1: REJECT ALL to LAN
e Source: VPN Subnets
e Destination: LAN Subnets
e This rule will block all traffic traveling to the LAN

Edit Firewall Rule

| Action Reject | v

Choose what to do with packets that match the criteria specified below

vith reject, a packet (TCP RST or ICMP port unreachable for UDP) is returned to the sender,

Hint: the differenc:

en block and reject is that

whereas with bloc cket is dropped silently. In either case, the original packet is discarded

Disabled ] Disable this rule

Set this option to disable this rule without removing it from the list

Interface VPN v

Choose the interface from which packets must come to match this rule

Address Family IPv4 v
Select the Internet Protocol version this rule applies to
Protocol Any v

Choose which IP protocol this rule should match

Source
Source ) Invert match bt / e
Destination
Destination ) Invert match LAN subnets b . / v
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Rule 2: ALLOW ALL
e Source: VPN Subnets
e Destination: Any (*)
e This rule will allow the VPN devices to communicate with the WAN and DMZ

Edit Firewall Rule

v
hat to do with packets that match the criteria specified below
Hint: the difference between block and reject is that with reject, a packet (TCP RST or ICMP port unreachable for UDP) is returned to the sender,

whereas with block the packet is dropped silently. In either case, the original packet is discarded

Disabled ] Disable this rule

Set this option to disable this rule without removing it from the list

Interface VPN

v

Choose the interface from which packets must come to match this rule

Address Family 1Pv4 v
Select the Internet Protocol version this rule applies to
Protocol Any v

Choose which IP protocol this rule should match

Source

Source ] Invert match VPN subnets > source Address / ad

Destination ] Invert match Any v Destinatio

Destination

Final VPN Firewall Rules

e NOTE: The REJECT ALL to LAN rule is listed as first priority. This will ensure that traffic
to the LAN will not be allowed!

Firewall / Rules/ VPN W E @

Floating WireGuard WAN LAN DMZ VPN

Rules (Drag to Change Order)

[m] States Protocol Source Port  Destination Port  Gateway Queue  Schedule Description Actions
(] 0/60B IPvd * VPN subnets 2 LAN subnets = & none REJECT ALL to LAN 3,000
0O « 0/0B IPv4 * VPN subnets * * * * none ALLOW ALL L200m%

D) D D (S ()
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WAN Rules
I need to allow VPN traffic from WAN clients into pfSense so they can properly connect.

Rule: ALLOW WireGuard VPN
e Pass
e Protocol: UDP
e Source: Any (*)
e Destination: WAN Address (pfSense public IP: 10.161.21.4)
e Port: 51820 (WireGuard Port)

Edit Firewall Rule

Pass v

Choose what to do with packets that match the criteria specified below.
Hint: the difference between block and reject is that with reject, a packet (TCP RST or ICMP port unreachable for UDP) is returned to the sender,
whereas with block the packet is dropped silently. In either case, the original packet is discarded

Disabled () Disable this rule

Set this option to disable this rule without removing it from the list

Interface WAN

w

Choose the interface from which packets must come to match this rule

Address Family IPv4 v

Select the Internet Protocol version this rule applies to.

UDP v

Choose which IP protocol this rule should match

Source [ Invert match Any

¥ Display Advanced

The Source Port Range for a connection is typically random and almost never equal to the destination port. In most cases this setting must remain at
its default value, any

Destination

Destination () Invert match WAN address v e / g
Destination Port Range (other) v 51820 (other) v 51820
From Custom To Custom
Specify the destination port or port range for this rule. The “To" field may be left empty if only filtering a single port.

New WAN Firewall Rules

Rules (Drag to Change Order)

States Protocol Source Port Destination Port Gateway Queue Schedule Description Actions
v 0/0B IPv4 UDP * *  WAN 51820 * none ALLOW WireGuard L2000
address b 4
v 1/324 IPva * * 19216823 53 (DNS) * none NAT $HS000
MiB TCP/UDP
) & 0/24KiB  IPv4TCP - = 192.168.2.3 80 (HTTP) = none NAT Port forward HTTP traffic to Apache Web L0000
Server
O v 0/263 IPv4 TCP ' *  192.168.2.3 443 * none NAT Port forward HTTPS traffic to Apache Web 5 S 0O T
MiB (HTTPS) Server

) D O G2
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WireGuard Client Setup

In order to connect to the newly created WireGuard VPN service on pfSense, we have to install
the proper client software on our WAN device. There is no need to install the software on the
LAN workstations since they are already on the internal network.

Login to your WAN client device
Open a browser and navigate to https://www.wirequard.com/install/
Download the Windows Installer

é WireGuard Installation  QuickStart  Interworkings -

Installation Insta”ation
Windows[7, 8.1, 10, 11,
2008R2, 2012R2, 2016, 2019, a8 Windows

2022]
Ml Download Windows Installer

macQOS [app store]
Ubuntu [module & tools]

. . & macOS
Android [play store & direct apk

file] & Download from App Store

Open the WireGuard application and go to the bottom left corner. Open the dropdown menu and

select “Add empty tunnel...”
| |
== Add Tunnel ~ | X

Import tunnel(s) from file... Ctrl+0
[] Addempty tunnel... Ctri+N

Public Keys

Client Public Key

Add a name for your tunnel and remember your client’s public key.
Tunnel Name: pfSense

Public Key: AQEDALWCBVqLzbh8YEI9PRokwWBzH++0J7p0EGaJd/g4=

Edit tunnel X

Mame: pfSense

Publickey: AQEDALWCBYqgLzbh8YEISPRokwWBzH++0]7p0EGal/g4=
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https://www.wireguard.com/install/

Server Public Key
Go back to pfSense and access your WireGuard VPN Tunnel to get the server’s public key.
WireGuard Server Public Key: YSZ33x10OWiYAYQHVc4geSH9jx5zhngwWLarok CGA4XI=

pfSense public WAN IP and Port: 10.161.21.4:51820

VPN / WireGuard/ Tunnels/ Edit

Tunnels Peers

Settings Status

ce®

it

il @

Tunnel Configuration (tun_wg0)

Enable
Description
Listen Port

Interface Keys

Peer Creation

Enable Tunnel

Note: Tunnel cannot be disabled when assigned to a pfSense interface

Description for administrative reference (not parsed)

51820
Port used by this tunnel to communicate with peers

............................................ YSZ33x10WiYAYQHVc4geSHIjx5zhngwWiarokCGAA4X
Private key for this tunnel. (Required Public key for this tunnel. (Copy)

New Keys

Stay in pfSense and create a peer connection by navigating to VPN > WireGuard > Peers and
selecting Add Peer.
Note: Public Key is the Windows Client public key!

Peer Configuration

Enable

Enable Peer

Note: Uncheck this option to disable this peer without removing it from the list

Tunnel

tun_wg0 v

Description

Dynamic Endpoint

Keep Alive

WireGuard tunnel for this peer. (Create a New Tunnel)

WAN Windows Client (Rebecca)

Peer description for administrative reference (not parsed

Dynamic

Note: Uncheck this option to assign an endpoint address and port for this peer

Keep Aliv
Interval (in seconds) for Keep Alive packets sent to this peer.
Default is empty (disabled).

Public Key

AQEDALWCBVqLzbh8YEISPRokwWBzH++0J7p0EGa/ga=

WireGuard public key for this peer.

Pre-shared Key

Optional pre-shared key for this tunnel. (Copy) New Pre-shared Key

Address Configuration

Hint

Allowed IPs

Add Allowed IP

Allowed IP entries here will be transformed into proper subnet start boundaries prior to validating and saving. These entries must be unique between
multiple peers on the same tunnel. Otherwise, traffic to the conflicting networks will only be routed to the last peer in the list

192.168.3.2 /| 32 v

IPv4 or IPv6 subnet or host reachable via this peer. Description for administrative reference (not parsed)
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Client Tunnel Configuration

Navigate back to your client device and finish configuring the new tunnel.

e [INTERFACE]

o Public Key = the static internal IP assignment when the client is connected

e [PEER]

o Public Key = pfsense’s public key for WireGuard

o Allowed IPs = the allowed subnets for traffic to route through
o Endpoint = public socket to connect to the VPN -> pfSenselP:WireGuard Port

Final Tunnel File

[Interface]

PrivateKey = +O+mVPd7VVyrhH8e+Vi3bejQQT7QxKfosRE/odgngmg=

Address = 192.168.3.2/24

[Peer]

PublicKey = YSZ33x1OWiYAYQHVc4geSH9jx5zhngwWLarokCGA4XI=

AllowedIPs = 192.168.3.0/24, 192.168.2.0/24
Endpoint = 10.161.21.4:51820

Note: The AllowedIPs section specifies which subnets will be routed through the VPN tunnel. In

this configuration, the client device will route traffic destined for 192.168.3.0/24 and
192.168.2.0/24 through the WireGuard tunnel. All other traffic will be sent via the device’s
regular network interface (NIC), effectively creating a “split tunnel” setup.

Edit tunnel

Name: pfSense

X

Public key: AQEDALWCBVqlLzbh8YEISPRokwWBzH++0]7p0EGalfad=

[Interface]
PrivateKey = +0+mVPd7VVyrhHBe+Vi3bejQQT7QxKfosRE/odgngmg=
Address = 192.168.3.2/24

[Peer]

PublicKey = YSZ33x10WIYAYQHVc4geSHISzhngwWiarokCGA4XI=
AllowedIPs = 192.168.3.0/24, 192.168.2.0/24

Endpoint = 10.161.21.4:51820

[ save |

Cancel
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VPN Testing

Client Testing
Once you have a proper tunnel file on the client device and a configured peer on pfSense,
Activate the tunnel within the WireGuard application.

€) WireGuard - a X
Tunnels Log
pfSense | Interface: pfSense
Status: Inactive

Public key:  AqEDALWCBVqLzbh8YEI9PRokw\WBzH++0J7p0EGa)/gd=
Addresses:  192.168.3.2/24

Activate

Peer

Public key: [¥SZ33x10WivAYQHVcdgeSHOjx5zhngwWLarokCGA4XI=
Allowed IPs: § 192.168.3.0/24, 192.168.2.0/24

Endpointy 10.161.21.4:51820

= Add Tunnel + | X Edit |

Once the tunnel is active, open a terminal to verify you are within the private VPN subnet with
the command: ipconfig
You should be able to see 2 network interfaces with an internal VPN IP and a personal IP.

PS C:\Users\Rebecca> ipconfig

Windows IP Configuration

Unknown adapter pfSense:

Connection-specific DNS Suffix . :

IPvY Address. . . . . . . . . . . 1 192.168.3.2
Subnet Mask . . . . . . . . . . . : 255.255.255.9
Default Gateway . -

Ethernet adapter Ethernet@:

Connection-specific DNS Suffix . : slick.firewall
Link-local IPv6 Address . . . . . : fe80::d6d:cc37:5d7b:1796%U
IPvl Address. . . . . . . . . . . :/10.161.21.20
Subnet Mask . . . . . . . . . . . : 255.255.255.0
Default Gateway . . . . . . . . . : feB80::250:56fF:feB2:c8d7%U
18.161.21.1
PS C:\Users\Rebecca>
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After verifying you are on the internal VPN subnet, try pinging a service in the DMZ such as the
web server (192.168.2.2) and then try pinging the LAN gateway (192.168.1.1).

The DMZ ping should succeed and the LAN ping should fail.

PS C:\Users\Rebecca> ping 192.168.2.1

Pinging 192.168.2.1 with 32 bytes of data:
Reply from 192.168.2.1: bytes=32 time=6ms
Reply from 192.168.2.1: bytes=32 time<lms
Reply from 192.168.2.1: bytes=32 time=1ms
Reply from 192.168.2.1: bytes=32 time<lms

Ping statistics for 192.168.2.1:

Packets: Sent = U, Received = U, Lost = © (®% loss),
Approximate round trip times in milli-seconds:

Minimum = Oms, Maximum = 6ms, Average = lms
PS C:\Users\Rebecca> ping 192.168.1.1

Pinging 192.168.1.1 with 32 bytes of data:
Request timed out.
Request timed out.
Request timed out.
Request timed out.

Ping statistics for 192.168.1.1:
Packets: Sent = U4, Received = 0, Lost = 4 (100% loss),

Server Testing
Within pfSense, navigate to VPN > WireGuard > Status and select the dropdown menu for your
tunnel. This will display current connections and successful VPN handshakes.

Status / WireGuard C®O=we
Tunnels Peers Settings Status
WireGuard Status
Tunnel Description Peers Public Key Address / Assignment MTU Listen Port RX ™
v A tun_wgo 1 YSZ33x10WIYAYQHV. .—z—. VPN 1500 51820 52 KiB 1.36 MiB
Peers Description Latest Handshake Public Key Endpoint Allowed IPs RX ™
1@ WAN Windows Clie 40 seconds ago AQEDALWCEVqLzbh8 10.161.21.20:54002 92.168.3.2/32 52KE  1.36MiB
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Appendix

The 3 Most Important Skills | have learned from CS 4400

1. Firewall and Local Network Configuration

Early in the course, | was tasked with configuring a pfSense firewall. Although | have
participated in numerous Cyber Defense competitions through the UNISEC Cyber Security club
at UNI, | had never been the teammate responsible for setting up a network-level firewall. My
experience was limited to host-based firewalls like UFW for Linux or Windows Defender. Booting
from the pfSense ISO, setting it up via the terminal, and then transitioning to the browser GUI
was a significant learning experience. It provided a refresher on networking concepts such as
subnetting, as | had to create two main internal subnets: LAN and DMZ. pfSense also
introduced me to creating firewall rules, NAT port forwarding from the WAN into the internal
subnets, and setting up services hosted on the firewall, such as the DNS Resolver, DHCP for
the LAN, and a WireGuard VPN service. It was incredibly rewarding to finally put computer
networking concepts into practice, physically seeing machines and services populate internal
networks and connect with each other. Overall, having experience in creating my own Home
Lab/Network Cluster will be a great topic to discuss during future job interviews!

2. DNS Configuration

After completing the firewall setup, properly configuring DNS was crucial for ensuring a fully
connected network cluster. | had never touched DNS settings on personal devices nor had |
ever configured a standalone DNS server before taking this course. My experience was limited
to understanding how DNS queries are forwarded through nameservers worldwide to resolve
domain names. The progression from setting up an internal caching DNS service on pfSense to
installing and configuring a standalone DNS server using BIND was highly beneficial. | started
with configuring a simple DNS caching mechanism and then advanced to setting up FQDN
mappings using Forward and Reverse lookup zones. DNS setup also involved getting familiar
with the nslookup and dig commands. nslookup is used to query DNS servers to obtain domain
name or |IP address mapping information, while dig provides detailed information about DNS
queries and responses, allowing for more advanced troubleshooting and analysis.

3. Active Directory Configuration

The most tedious task of this course was setting up Active Directory on the Windows server. |
learned that setting up services on Windows devices involves a lot of “wizards” and GUIs while
services on Linux involve the command line and simple configuration files. | prefer the former
but it was definitely beneficial to set up AD since it is a common enterprise deployment. For
example, my own university uses AD for everything! After completing the initial installation and
designating the Windows Server as a Domain Controller, it was fascinating to set up Forward
and Reverse lookup zones. Active Directory actually uses DNS to connect to and authenticate
client workstations. The setup concluded with creating a new forest and establishing an
Organizational Unit (OU). Having some experience with AD will help with enterprise scenarios.
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